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What’s New in 1.3.1?
Foreword

Welcome to the 1.3.1 release of Red Hat eCos(TM) - the Embedded Configurable 
Operating System.

What’s New in 1.3.1?
In this, the third major public release of eCos, we have added a wealth of new features, 
enhancements, and have further extended the target platform coverage.

The configuration system has been completely revised and updated. Major new 
elements include: 

■ Package management that supports the extension of eCos functionality via third 
party add-on packages.

■ A standardized configuration save file format that is human readable and editable, 
and compatible between both GUI and command line configuration tools.

■ Enhanced web based help and component documentation system integrated into 
the GUI configuration tool.

■ The Component Definition Language (CDL) has been radically revised and has 
now been implemented as a TCL extension for maximum flexibility. CDL is now 
fully documented in the Component Writers Guide.

■ Template support for straightforward control of multiple configuration elements, 
which can be used to provide easy access to standard eCos configurations such as 
a debug stub boot ROM.

■ Best of all, the source of the new configuration tools and underlying libCDL 
technology has been open sourced under the GNU Public License (GPL).

A companion beta version of the eCos TCP/IP stack has been released in conjunction 
with 1.3.1. The stack is derived from the OpenBSD source base and provides UDP, 
TCP, ICMP and BOOTP protocol support on an IPv4 standards base. Device driver 
support for Cirrus Logic EP72xx evaluation boards and Motorola MBX is included. 
The stack, ethernet core support, and device drivers are all distributed as configurable 
eCos packages.
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eCos in a Nutshell
A PCI bus support library has also been added that provides generic PCI bus based 
device initialization, discovery, and configuration. The library has been ported to both 
the VR4300 DDB-VRC4373 and StrongARM EBSA285 development boards.

New architectures and platforms added in this release include: 

■ ARM Thumb

■ ARM9

■ Cirrus Logic CL-PS7111 and EP72xx

■ Cogent CMA222 and CMA230 ARM boards

■ Hitachi SH3

■ Intel StrongARM

■ Intel x86 PC

■ Matsushita AM33

■ Motorola MBX evaluation board

■ NEC MIPS VR4300

For further details of all the changes see the NEWS file in the eCos sources.

This is the first release of eCos since the merger of Red Hat and Cygnus Solutions was 
completed. Red Hat is dedicated to continued enhancement and maintenance of the 
eCos system. Developers can look forward to upcoming releases that further expand 
the architectural and board coverage, extend the functionality of the TCP/IP stack, add 
a Linux version of the GUI configuration tool, and add major new features such as a 
Linux/Posix compatibility layer based on the upcoming EL/IX standard - see

http://sourceware.cygnus.com/elix/ 
for more details.

The merger has brought about some minor changes to eCos’s Mozilla-derived public 
license, the most fundamental of which is simply the change of name from Cygnus 
eCos Public License (CEPL) to Red Hat eCos Public License (RHEPL). The license 
terms themselves have not changed in any material way other than alterations 
necessary to accommodate the change in company details.

eCos in a Nutshell
eCos is an open source, configurable, portable, and royalty-free embedded real-time 
operating system. The following text expands on these core aspects that define eCos.

eCos is provided as an open source runtime system supported by the Red Hat GNUPro 
and GNU open source development tools. Developers have full and unfettered access 
to all aspects of the runtime system. No parts of it are proprietary or hidden, and you 
are at liberty to examine, add to, and modify the code as you deem necessary. These 
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eCos in a Nutshell
rights are granted to you and protected by the Red Hat eCos Public License (RHEPL). 
It also grants you the right to freely develop and distribute applications based on eCos. 
You are not expected or required to make your embedded applications or any 
additional components that you develop freely available, although we do require that 
you make publicly available any modifications to the eCos code itself. Red Hat of 
course welcomes all contributions back to eCos such as board ports, device drivers 
and other components, as this helps the growth and development of eCos, and is of 
benefit to the entire eCos community.

One of the key technological innovations in eCos is our configuration system. The 
configuration system allows the application writer to impose their requirements on the 
run-time components, both in terms of their functionality and implementation, 
whereas traditionally the operating system has constrained the application’s own 
implementation. Essentially, this enables eCos developers to create their own 
application-specific operating system and makes eCos suitable for a wide range of 
embedded uses. Configuration also ensures that the resource footprint of eCos is 
minimized as all unnecessary functionality and features are removed. The 
configuration system also presents eCos as a component architecture. This provides a 
standardized mechanism for component suppliers to extend the functionality of eCos 
and allows applications to be built from a wide set of optional configurable run-time 
components. Components can be provided from a variety of sources including: the 
standard eCos release; commercial third party developers; open source contributors; 
or additional optional components from Red Hat.

The royalty-free nature of eCos means that you can develop and deploy your 
application using the standard eCos release without incurring any royalty charges. In 
addition, there are no up-front license charges for the eCos runtime source code and 
associated tools. We provide, without charge, everything necessary for basic 
embedded applications development.

eCos is designed to be portable to a wide range of target architectures and target 
platforms including 16, 32, and 64 bit architectures, MPUs, MCUs and DSPs. The 
eCos kernel, libraries and runtime components are layered on the Hardware 
Abstraction Layer (HAL), and thus will run on any target once the HAL and relevant 
device drivers have been ported to the target’s processor architecture and board. 
Currently eCos supports seven different target architectures (ARM, Hitachi SH3, Intel 
x86, MIPS, Matsushita AM3x, PowerPC and SPARC) including many of the popular 
variants of these architectures and evaluation boards. Many new ports are in 
development and will be released as they become available.

eCos has been designed to support applications with real-time requirements, providing 
features such as full preemptability, minimal interrupt latencies, and all the necessary 
synchronization primitives, scheduling policies, and interrupt handling mechanisms 
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eCos in a Nutshell
needed for these type of applications. eCos also provides all the functionality required 
for general embedded application support including device drivers, memory 
management, exception handling, C, math libraries, etc. In addition to runtime 
support, the eCos system includes all the tools necessary to develop embedded 
applications, including eCos software configuration and build tools, and GNU based 
compilers, assemblers, linkers, debuggers, and simulators.

To get the most out of eCos you should visit the eCos open source developers site:
http://sourceware.cygnus.com/ecos/ 

The site is dedicated to the eCos developer community and contains a rich set of 
resources including news, FAQ, online documentation, installation guide, discussion 
and announcement mailing lists, online problem report form, and runtime and 
development tools downloads. We also support anonymous CVS and WEBCVS 
access to provide you with direct access to the very latest eCos source base. 
Complementing the open source developers site is an eCos product site, featuring 
news, press releases, details of our commercial engineering and support services, 
products, and third party partner offerings. This is located at 

http://www.redhat.com/services/ecos/

We have released eCos as open source software because we believe that this is the 
most effective software development model, and that it provides the greatest benefit to 
the embedded developer community as a whole. As part of this endeavor, we seek the 
input and participation of eCos developers in its continuing evolution. Participation 
can take many forms including:

■ providing us with feedback on how eCos might be made more useful to you - by 
taking part in the ongoing mailing list discussions and by submitting problem 
reports covering bugs, documentation issues, and missing features

■ contributing bug fixes and enhancement patches

■ contributing new code including device drivers, board ports, libraries, and other 
runtime components

Our long term aim is to make eCos a rich and ubiquitous standard infrastructure for 
the development of deeply embedded applications. This will be achieved in part by 
Red Hat’s own efforts, but also with the assistance of the eCos developer community 
cooperating to improve eCos for all. I would like to take this opportunity to extend our 
thanks to the many eCos developers who have already contributed feedback, ideas, 
patches, and code that have augmented and improved this release.

On behalf of the eCos team, welcome to the eCos developer community.

Paul Beskeen, 
Director of Engineering, 
eCos March 2000 
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Getting Started with eCos
Documentation Roadmap

Getting Started with eCos
Release Notes 

Description of this release. 

Installation Guide 

Hardware and software installation instructions, including instructions on how to 
execute some prebuilt tests to verify the installation.

Programming Tutorial 

A tutorial that gets you started running programs with eCos. 

Appendixes 

Extra information about the licensing terms for eCos. 

eCos User’s Guide
The eCos Configuration Tool 

A description of all features of the Configuration Tool. 

Programming concepts and techniques 

An explanation of the eCos programming cycle, and a description of some 
debugging facilities that eCos offers. 

Configuration and the Package Repository 

1
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eCos Reference Manual
Information on how to configure eCos manually, including a reference on the 
ecosconfig command, memory layouts,  and information on how to manage a 
package repository using the eCos Package Administration Tool. 

eCos Reference Manual
Preliminaries 

An overview of the eCos kernel and configurability system. 

Kernel APIs 

In-depth description of eCos’s native C kernel API, the µITRON API, the ISO 
standard C library, and the eCos Hardware Abstraction Layer (HAL). Important 
considerations are given for programming the eCos kernel. The semantics for 
each kernel function are described, including how they are affected by 
configuration. 

eCos Device Drivers 

A description of the philosophy behind eCos device drivers, as well as a 
presentation of the C language API for using the current device drivers. 

The ISO Standard C and Math Libraries 

eCos comes with an implementation of the ISO C library specification. This 
section gives details about the implementation, lists the few functions that are not 
yet implemented, and gives a complete reference for configuring the C library. 
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Part I: Release Notes

eCos 1.3.1 supports the following architectures: 

This release of eCos supports the following architectures:

■ Advanced RISC Machines ARM7 and ARM9 (including Thumb support on the 
appropriate cores)

■ Intel SA-110 StrongARM 

■ Linux i386—synthetic Linux target 

This release of eCos supports the following target platforms:

■ ARM PID (ARM7/ARM7t/ARM9)

■ ARM AEB-1 (revision B and C) evaluation boards

■ Cirrus Logic CL-PS7111 (ARM710A CPU) evaluation board, also known as 
EB7111

■ Cirrus Logic EP7209, EP7211 and EP7212 development boards (ARM720T 
CPU) also known as EDB7209, EDB7211 and EDB7212 respectively.

■ Cogent CMA 101/102 evaluation boards with CMA230 (ARM7tdmi) and 
CMA222 (ARM710) daughterboards —support for this platform is still “beta”

■ StrongARM EBSA-285 evaluation board

■ Linux (i386) - synthetic Linux target

This release of eCos supports the following host operating systems: 

■ UNIX —support for UNIX is still “beta”. Redhat Linux  and Solaris  are the 
only tested UNIX variants. 

Microsoft® Windows NT®, Windows 95®, Windows 98®, Windows 2000®—
support for Windows 95, 98 and 2000 is still “beta”. 
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GDB and GCC Command Notation
Notation and Conventions

Since there are many supported target architectures, notation conventions will be used 
to avoid repeating instructions which are very similar. 

GDB and GCC Command Notation
Cross-development commands like gcc and gdb will be shown without prefixed 
information about the platform for which you are cross-compiling. You need to add 
the necessary prefix before you execute the commands, so instead of typing ‘gcc’ and 
‘gdb’ as in the examples, use:
arm-elf-gcc/thumb-elf-gcc and arm-elf-gdb/thumb-elf-gdb for ARM/Thumb

i686-pc-linux-gnu-gcc and i686-pc-linux-gnu-gdb for i386

Note that the GCC cross compiler generates executable files with the .exe suffix on 
Windows, but not on UNIX. The suffix .exe will be omitted from executable file 
names, so you will see hello instead of hello.exe.

Directory and File System 
Conventions

The default directory for installing eCos on Windows (usually C:/Program Files/
Red Hat/eCos) is different from that on UNIX (usually /usr/local/ecos-v1_3_1). 
Since many command line examples in the tutorials use these paths, this default (base) 
directory will be shown as BASE_DIR.

2
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Directory and File System Conventions
Windows and UNIX have similar file system syntax, but the MS-DOS command 
interpreter on Windows uses the backslash character (\) as a path separator, while 
UNIX and POSIX shells (including the Cygwin bash shell for windows) use the 
forward slash (/).

This document will use the POSIX shell convention of forward slashes.
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Hardware Abstraction
Overview of the Release

The Embedded Configurable Operating System (eCos) software is a set of tools and a 
run-time environment for developing embedded applications. eCos is a configurable, 
open source system that allows you to build a run-time system that closely matches 
the needs of your application. 

eCos is aimed at embedded software developers using architectures with tight 
memory requirements, who want a portable framework for developing their 
applications.

This chapter outlines the features of eCos version 1.3.1. The initial release version was 
1.3, and additional 1.3 releases will incorporate an additional number, represented in 
this manual by “x”. Please note the exact version number of the version that you are 
using, because it is incorporated in certain file paths.

If you want to start programming eCos immediately, see “Part II: Installation Guide” 
on page 30 and “Part III: Programming Tutorial” on page 60. 

Hardware Abstraction
eCos includes a Hardware Abstraction Layer (HAL) that hides the specific features of 
each CPU and platform so that the kernel and other run-time components can be 
implemented in a portable fashion. 

The eCos HAL has now been ported to numerous architectures, and to one synthetic 
target, Linux i386. Notes on porting the HAL to new platforms are provided in the 
eCos Reference Manual, part: The eCos Hardware Abstraction Layer, section: Kernel 
porting notes. 

3
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Embedded Kernel
Embedded Kernel
The core of eCos is a full-featured, flexible, and configurable embedded kernel. 

The kernel provides, among other features, multi-threading, a choice of schedulers, a 
full set of synchronization primitives, memory allocation primitives, and thread 
manipulation functions (see the eCos Reference Manual for the full kernel API).

The kernel is designed so that some parts of it can be changed or replaced without 
affecting other kernel components. 

The following is a partial list of kernel features:

■ choice of memory allocation algorithm 

■ choice of scheduling algorithm

■ a rich set of synchronization primitives 

■ timers, counters, and alarms 

■ interrupt handling

■ exception handling

■ cache control 

■ thread support 

■ kernel support for multi-threaded debugging with GDB

■ trace buffers

■ infrastructure and instrumentation 

The kernel API and configuration are described in the eCos Reference Manual. 

Configurability
The eCos kernel and other components can be configured in great detail at compile 
time, avoiding the addition of unwanted code to the library to be linked with your 
application code. There is no performance penalty for configuration.

Configuration is fine-grained, so that very small details of eCos’ behavior can be 
tuned by selecting configuration options. 

eCos is organized as a component architecture, with a language to describe the 
constraints between components and individual configuration options. These 
constraints are necessary to resolve inconsistent configurations, such as disabling the 
code which handles the real-time clock, while enabling per-thread timers.
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µITRON and Other Operating Systems
The designer of a component or general-purpose library should write configurable 
code using a component definition language (CDL). Once that has been done there is 
no additional burden on the end user (i.e. an embedded systems programmer), who 
will be able to use eCos’ graphical Configuration Tool to configure the kernel and 
basic libraries without needing to understand how the configuration infrastructure 
works.

A tutorial on how to configure eCos is located in “Configuring and Building eCos 
from Source” on page 64. The eCos User’s Guide has complete information on 
running the Configuration Tool and CDL. 

µITRON and Other Operating 
Systems

eCos’ configurability is the key to simulating different operating systems by using 
compatibility layers on top of eCos’ kernel, because the semantics of basic kernel 
functions can be configured to match the semantics of other operating systems.

The specification for the  µITRON operating system has been implemented on top of 
eCos. µITRON is configured by selecting appropriate options in the kernel (a real-
time clock, the mlqueue scheduler, and no timeslicing); and writing a thin layer to 
map the µITRON system calls.

The µITRON port implements the complete µITRON 3.02 “Standard functionality” 
(level S) specification, as well as some of the “Extended” (level E) functions. The 
µITRON implementation is described in more detail in the eCos Reference Manual. 

ISO C Library
The ISO C and math library shipped with eCos was written to be configurable and 
tightly integrated with the kernel and the HAL.

By carefully selecting configuration options in the C library, you can significantly 
reduce the size of the final executable image. 
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Serial Device Drivers
Serial Device Drivers
eCos provides serial device drivers for all supported eCos platforms, with the 
exception of the i386 Linux synthetic target and most simulator platforms. The serial 
drivers provide an API (documented in the eCos Reference Manual) to control serial 
ports directly. The standard I/O library can be configured to use them as a transport 
layer.

ROM Monitor Image
eCos ships with a CygMon ROM monitor for the MN10300, TX39, SPARClite, 
EDB7211, EDB7212 and EP7211 Development Boards. This includes a GDB stub, 
thus allowing GDB to be used to debug eCos applications on these evaluation boards. 
In addition to shipping the actual ROM, the image of that ROM is provided in case 
you need to burn identical copies for additional boards (see “Target Setup” 
on page 35). 

For the ARM PID, ARM Cogent, ARM AEB, Cirrus Logic EDB7211 and EDB7209/
7212 and i386 PC, the ROM images include a GDB stub. This allows GDB to connect 
to the board and download eCos programs. 

For the ARM AEB-1 EBSA 285, the ROM image includes a GDB stub that can be 
installed in the FLASH ROM on the board.

NOTE When an eCos program is run on ARM or SH3 boards, the GDB stub in ROM 
does not provide thread debugging or asynchronous GDB interrupt support. If 
you require full debugging capabilities, you must include GDB stub support 
when configuring eCos.

No ROM image is required for the synthetic Linux target.

For the port of CygMon to the EP7211 and EP7212 Development Boards, the source 
code to CygMon is included as an integral part of eCos. See “Cirrus Logic ARM 
EP7211 Development Board Hardware Setup” on page 47 for information on how to 
rebuild CygMon for the EP7211.

Please note that previous releases of CygMon are incompatible with eCos. You must 
use the version of CygMon that is provided with eCos rather than an older version of 
CygMon.
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Tests and Examples
Tests and Examples
Test suites are included for every portion of eCos shipped in this release; these are 
brief programs that test the behavior of most system calls and libraries in eCos. “Test 
Suites” on page 76 describes how to build and run these test suites.

The last chapters in “Part III: Programming Tutorial” on page 60 give examples that 
guide you through running eCos applications, starting from a “Hello world” program 
and then moving on to more complex programs that use additional kernel features. 

GNU Tools and their Documentation
Red Hat’s GNUPro Toolkit, which includes the GCC and G++ compilers and the 
GDB debugger, is needed to build eCos applications. It is bundled with the CDROM 
distribution of the eCos Developer’s Kit, and is also available on the net at http://
sourceware.cygnus.com/ecos/.

Online HTML versions of the full GNUPro documentation are included with eCos, as 
well as a specific GNUPro tools reference guide for your hardware architecture, 
customized for use with eCos. The full GNUPro documentation can also be found on 
the web at http://www.redhat.com/support/manuals/gnupro.html
NOTE The Linux synthetic i386 target is an exception, as there is (currently) no 

GNUPro manual. However, the GNUPro source archive contains 
documentation for the tools. This documentation is usually also included as 
part of a default Red Hat Linux installation, accessible with the info program.

eCos Documentation
The eCos documentation set includes Getting Started with eCos, the eCos User’s 
Guide, the eCos Reference Manual, and a GNUPro Reference Manual for your 
specific architecture.

For users of the eCos Net releases, these are available online in HTML format at 
http://sourceware.cygnus.com/ecos/.
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eCos Net Release
Package Contents

eCos Net Release
The eCos Net release consists of the archive files for GNUPro and eCos, which are 
located on the Red Hat eCos web site 

http://sourceware.cygnus.com/ecos/

The eCos Net release, because it is digitally distributed only, does not provide ROM 
images for the various development boards. However, the ROM images for the 
supported hardware platforms are included in the distribution, so you can burn your 
own ROM/Flash ICs to work with eCos. 

HTML versions of the GNUPro and eCos manuals are included in the distribution, 
and are also available online.

eCos Developers’ Kit
If you have a CD distribution of the eCos Developer’s Kit, you will find the following 
items in your package:

■ A card to request printed eCos documentation (Getting Started with eCos, the 
eCos User’s Guide, and the eCos Reference Manual), and the complete GNUPro 
documentation suite, including an eCos-specific reference manual for your 
architecture.

With the card you can also request a copy of µITRON 3.0 An Open and Portable 
Real-Time Operating System for Embedded Systems, a book by Dr. Ken 

4
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ARM Package
Sakamura.

■ eCos version 1.3.1 CDROM with source code and precompiled binaries.

ARM Package
The ARM package contains an eCos-specific PROM for the PID evaluation board or 
the Cogent evaluation board. This PROM contains a Thumb-aware stub. There are no 
extras for the AEB-1, EDB7111 or EDB7211 boards in the Developer’s Kit.

StrongARM Package
The StrongARM package contains no extras for the EBSA-285 board in the 
developers’ kit.
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Required
System Requirements

Required
■ Standard Intel  architecture PC running Linux (tested on Red Hat Linux 

distributions 5.0-6.1). Other versions of Red Hat distributions, or Linux 
distributions from other vendors should work as well. Also, English or Japanese 
versions of Microsoft Windows NT version 4.0 (service pack 3 or above must be 
installed), Windows 95, Windows 98, or Windows 2000.

Sun  workstation running Solaris 2.5.1 or later for the SPARC .

Support for any platform except for Windows NT 4.0 and Solaris 2.5.1 is beta. In 
particular, it is only possible to rebuild the GNUPro compiler toolchain on 
Windows NT 4.0,  Solaris 2.5.1, and Linux. 

■ Enough disk space for the installed distribution. The eCos installation process will 
detail the various components of eCos and the GNUPro toolkit that can be 
installed, and their disk space requirements.

■ 64MB of RAM and a 350MHz or faster Pentium processor.

If you are downloading the eCos Net Release distribution from Red Hat’s 
Sourceware site, you will also need space to store that image and to compile 
GNUPro and eCos from source.

If you will be using the ARM PID evaluation board, you will also need: 

■ One (16550 based) serial port on the PC

■ ARM PID evaluation board with eCos GDB stubs ROM installed, or GDB stubs 
programmed in the flash ROM (see “ARM PID Hardware Setup” on page 37). 

5
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Required
■ Null modem cable to connect the serial port on the PC to the SerialA serial I/O 
connector on the evaluation board.

If you will be using the ARM AEB-1 evaluation board, you will also need: 

■ One (16550 based) serial port on the PC

■ ARM AEB-1 evaluation board with eCos GDB stubs ROM image installed in the 
flash ROM. 

■ Null modem cable to connect the serial port on the PC to the serial I/O connector 
on the evaluation board.

If you will be using the Cogent CMA230 evaluation board, you will also need: 

■ One (16550 based) serial port on the PC

■ Cogent CMA101/102 evaluation board with a CMA (ARM7tdmi) daughterboard 
and eCos GDB stubs ROM  installed. Information and online manuals for the 
Cogent board can be found at http://www.cogcomp.com/.

■ Serial cable to connect the serial port on the PC to the RJ-11 serial I/O connector, 
P11 (CMA101) or P3 (CMA102), on the evaluation board.

If you will be using the Cirrus Logic CL-PS7111 Evaluation Board, you will also 
need:

■ One 16550-based serial port on the PC.

■ A Cirrus Logic CL-PS7111 Evaluation Board with an eCos GDB stubs ROM 
image installed in the flash ROM.

■ Custom cable that is supplied with the CL-PS7111 Evaluation Board connected 
from a serial port on the PC to the serial I/O connector labelled “Serial Port 1”.

If you will be using the Cirrus Logic EP7209, EP7211 or EP7212 Development 
Boards, you will also need:

■ One 16550-based serial port on the PC.

■ A Cirrus Logic ARM EP7211 or EP7212 Development Board, with either a 
CygMon ROM Monitor image or a GDB stub ROM image installed in the flash 
ROM.

■ If connecting with a serial cable, use a null modem cable to connect the serial port 
on the PC to the serial I/O connector labelled “UART 1” on the EP7211 
Development Board, and “Serial Port 0” on the EP7209 and EP7212 
Development Boards. A gender changer may also be required.

■ If connecting using the ARM Multi-ICE Interface Unit, in the interests of stability 
it may be a useful precautionary measure to run the ARM Multi-ICE server on a 
separate Windows 9x/NT machine.
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Recommended
If you will be using the Intel StrongARM EBSA-285 evaluation board, you will also 
need: 

■ One (16550 based) serial port on the PC

■ Intel StrongARM EBSA-285 evaluation board with eCos GDB stubs ROM image 
installed in the flash ROM. 

■ Null modem cable to connect the serial port on the PC to the serial I/O connector 
on the evaluation board. A gender changer may also be required.

If you will be using the Linux synthetic target, you will also need: 

■ An ix86 PC with an installed Linux distribution (tested with Red Hat Linux 
distributions 5.0 - 6.1). 

Recommended
■ We recommend that Windows NT users install Internet Explorer 4.0 or later, since 

this will allow the Configuration Tool’s documentation panel to be searchable. 

■ A Pentium II computer and 64MB or more of RAM are recommended for best 
build performance.

The system has been tested only in the recommended configuration above, although 
other configurations are expected to work.
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How to Report Problems
Reporting Problems

Reporting bugs and other problems is very important: it allows Red Hat to solve your 
problem quickly, and improves the eCos product. The effort you make in reporting 
problems is appreciated.

To submit a problem report, please use the web interface. If you have a CD 
distribution of the eCos Developer’s Kit, you should use the address:

http://support.cygnus.com.

You will need a login name and an ID, provided by your administrator.

If you are using the eCos Net release you should use the address

http://sourceware.cygnus.com/ecos/problemreport.html. 

Known Bugs in eCos and GNUPro
Before filing and bug reports, however, please read the README provided with this 
release. It describes known problems and possible workarounds in eCos or with the 
GNUPro Toolkit. The file is at the base of the distribution.

How to Report Problems
For documentation discussing the means to report on, edit and query problems, see the 
following  Accessing Red Hat Web Support to report problems, or Additional options 
in this chapter.

6
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Accessing Red Hat Web Support to Report Problems
This documentation serves only as a guide and it is not meant to supercede the Help 
documentation on the Web Support site. We have tried to make our software as 
trouble-free as possible. If you do encounter problems, we’d like to diagnose and fix 
the problem as quickly as possible. 

Accessing Red Hat Web Support to Report Problems
If you have a CD distribution, use the following instructions to access the Red Hat 
Support website.

■ Use the following URL in your web browser’s address or location dialog box.

      http://support.cygnus.com

■ Click on the Case Management System icon, enter your ID and password, and the 
Welcome page will be displayed.

Access the Welcome page at any time by using the Welcome link (in the 
navigation bar on the left side of each Web Support page).

If you have the CD distribution, your details will have been entered in the 
database, and will be displayed on the Welcome page. If you wish to alter these 
details, select the Profile link in the navigation bar on the left side of the page.

■ Use the links included in the navigation bar on the left side of the page to perform 
any of the following Red Hat Web Support activities.

❒ New Case (see Submitting a support request, and  the Red Hat Support 
website) 

❒ Query Case (see Additional options, and the Red Hat Support website) 

❒ Add Notes (see Additional options, and the Red Hat Support website) 

❒ Find Solutions (see Additional options, and the Red Hat Support website) 

❒ Profile (see Additional options, and the Red Hat Support website) 

❒ Help documentation see Additional options, and the Red Hat Support 
website) 

❒ Close Case (see Additional options, and the Red Hat Support website)

Submitting a Support Request
Use the following instructions to submit a support request, once you have a valid ID 
established.

■ Click on New Case to create a new reported problem case.

The New Case page allows you to complete the creation of a new case. If there is 
more than one site, select the site relating to your problem.

■ Click on Use This Site ID button to display a list of the relevant products.
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Additional Options
■ Select a product from the list and then click on the Create Case for Selected 
Product button.

Each customer has a valid list of parts of Red Hat products for which they can 
submit problem reports. These components are part of the Web Support database.

■ Type a brief description of the case in the Case Title field. You can enter up to 
80 characters in this field.

■ Select a case type from the Type drop-down menu that best describes the case.

■ Select a customer severity level from the Severity drop-down menu that best 
describes how severe you view this problem.

■ Select a case priority level from the Priority drop-down menu that best 
describes the priority of this case to Red Hat.

■ Type a complete description of your case in the Problem Description field.

Use the scrollbars to scroll text in this field. You can add up to 30 kilobytes of text 
in this field.

■ Click on the Create Case button at the bottom of the page to create the case in the 
Red Hat Web Support database. Alternatively, clear the input fields on the New 
Case page, using the Clear button.

After you create your case, the Case Details page displays, which includes the Case ID 
number that the support database assigns to your case.

To create a new case for a different site and/or part, click the New Case link in the 
navigation bar; then use the previous instructions.

Additional Options
The following documentation discusses the other features for the Red Hat Web 
Support site. Red Hat has a database to help in determining when problems developed, 
tracking the problems case from their first report through analysis and resolution. The 
database can also be used for correlation with other products as well as to other related 
problems.

■ Click on Query Case to find an existing problem case in our database. 

You may examine problem cases in the Red Hat Web Support database, searching 
by solution ID or by entering keywords and/or a key phrase. There are options on 
this page enabling you to control how your search works.

At this point, view a problem case’s details, check its status, add notes or close a 
problem.

■ Click on Add Notes to add additional data to an existing case in our database. 
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Additional Options
■ Click on Find Solutions to search for problem solutions in the database. The 
search will provide a list of the current problem cases in the Red Hat Web Support 
database.

■ Click on Profile to change your profile information and/or your Web Support 
password in our database. A Profile page wil be displayed. 

■ Click on Help for questions about using the Web Support page. The online help 
documentation for the Web Support site supercedes this guide; it is not meant to 
supercede the more updated Help documentation for the Web Support site. 

■ Click on Close Case link to close a case. Closing a case brings the problem to its 
resolution.

Updating your profile
Clicking on Profile allows you to enter the following details.

■ Your contact name 

■ The primary phone number where Red Hat Support can contact you 

■ FAX number Red Hat Support can use to send you information 

■ Your e-mail address 

■ Your site ID, used to identify your primary site in the Web Support database 
(a Red Hat representative will provide this information) 

■ Your site name 
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Part II: Installation Guide
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Software Installation on Windows
Software Installation

Software Installation on Windows
If you have a CD distribution of the eCos Developer’s Kit, you have received the eCos 
software and its supporting utilities on a single CDROM for installation on a PC-
compatible computer running Windows NT 4.0, Windows 95, or Windows 98. If you 
use NT you must apply the NT 4.0 Service Pack 3 or above before installing eCos. 
Support is only for Windows NT 4.0. Installations on other Windows platforms are 
beta.

The following components are provided on the eCos CDROM: 

■ eCos source code

■ Prebuilt eCos libraries and tests

■ eCos documentation

■ Red Hat GNUPro compiler toolchain for eCos source code compilation

■ Red Hat Cygwin environment: this product provides a POSIX compatibility layer 
on top of Windows NT, and supports the GNUPro tools on Windows NT.

■ The GNU user tools—a collection of utilities that developers, particularly those 
with a UNIX background, will find useful. However, they are not supported by 
Red Hat.

■ Documentation for the GNUPro tools, including a Reference Manual for the 
particular evaluation board being used to run eCos.

7
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Software Installation on UNIX
If you have obtained the Net release of eCos for Windows, you will have the 
distribution in a self-extracting archive. Apart from the difference in medium, the 
installation procedure for eCos itself will be the same as for the CDROM-based 
distribution. 

The software installation process involves a number of installation utilities. Some 
familiarity with Windows is assumed.

1. Invoke the file Setup.exe on the CDROM. This will start the installation 
procedure. If you have the autorun feature enabled, Windows will run Setup.exe 
automatically when the CDROM is inserted into the drive.

2. The setup program will offer to install the GNU user tools. Click Ok. 

3. You will be prompted for a path in which to install the GNU user tools. The 
default will be in the /cygnus/gnupro/i686-cygwin32/i686-cygwin32 
hierarchy (usually on drive C). It will then offer to install the source code and 
documentation for the GNU user tools. It is recommended that you install the 
documentation, but not the source code, unless you are interested in modifying or 
recompiling the GNU user tools. 

4. At this point the setup program will begin installing eCos. Click Ok.

5. The default path offered for eCos installation will be in the /Program Files/Red 
Hat hierarchy (usually on drive C). You may change this path, and indeed you 
will need to change it if that partition does not have sufficient free disk space 
available. It is recommended that you accept the default selection of software 
components for installation.

6. You will be asked to select the program folder under which the eCos menu items 
will be placed. The default folder name is Red Hat eCos. 

7. The installation should finish normally, offering to show you the README file that 
contains any last minute information and a list of known problems detected after 
this document was printed. Once the installation is finished, you can start eCos or 
view the online documentation by selecting Start -> Programs -> Red Hat eCos, 
and then choosing an option within this folder, e.g Configuration Tool, Package 
Administration Tool, etc. 

At this point you are ready to configure and build a customized eCos kernel as 
described in “Configuring and Building eCos from Source” on page 64. 

Software Installation on UNIX
Installation and build instructions for the eCos Net release are available on the Red 
Hat eCos web site http://sourceware.cygnus.com/ecos/
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Software Installation on UNIX
Users of the eCos Developer’s Kit under UNIX should use the following instructions, 
which assume that the CD-ROM is available at /cdrom/cdrom0.

1. Extract the eCos repository from the compressed tar archive ecos-131.taz, 
located in the root directory of the CD-ROM using the following commands:

# mkdir /usr/local
# cd /usr/local
# zcat < /cdrom/cdrom0/ecos-131.taz | tar xvf -

On completion, the eCos repository may be found in the directory /usr/local/
ecos-1.3.1.

2. Extract the eCos development tools from the compressed tar archive tool-
bin.taz, located in the root directory of the CD-ROM, using the following 
commands:

# mkdir /usr/cygnus
# cd /usr/cygnus
# zcat < /cdrom/cdrom0/tool-bin.taz | tar xvf -

On completion, the executable files of the eCos development tools may be found 
in the directory /usr/cygnus/ecos-DEVTOOLSVERSION/H-host-triplet/bin. 
The source code for the development tools may optionally be installed in the same 
way:

$ zcat < /cdrom/cdrom0/tool-src.taz | tar xvf -

3. Add the eCos development tools and any native tools supporting the eCos build 
process to the front of your path. Under Solaris, for example, you should modify 
the PATH environment variable as follows.

Using sh, ksh, or bash:

$ PATH=/usr/cygnus/ecos-99r1-991015/H-sparc-sun-solaris2.5/bin:/
usr/xpg4/bin:/usr/ucb:$PATH
$ export PATH

Using csh or tcsh:

Note that csh also requires the shell command "rehash" after modifying the path 
for the path change to take effect.

% setenv PATH  /usr/cygnus/ecos-99r1-991015/H-sparc-sun-solaris2.5/
bin:/usr/xpg4/bin:/usr/ucb:$PATH
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Software Installation on UNIX
At this point you are ready to configure and build a customized eCos kernel as 
shown in “Configuring and Building eCos from Source” on page 64. 

NOTE The order of directories in the PATH is very important, and build failures may 
result if the PATH is not set correctly. If you are having difficulties in 
building eCos, please make sure you have set the PATH exactly as above.
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Connecting To A Target Via Serial
Target Setup

Connecting To A Target Via Serial
While eCos supports a variety of targets, communication with the targets happens in 
one of four ways. These are descibed in general below.

The descriptions are followed by descriptions of each target, providing specific details 
of how to set up the target (if hardware) and the necessary communication information 
(such as baud rate for hardware targets, or special connection options for simulator 
targets).

Most targets will have eCos GDB stubs or CygMon installed. These normally wait for 
GDB to connect at 38400 baud, using 8 data bit, no parity bit and 1 stop-bit (no 
hardware flow control). Check the section for your target to ensure it uses this speed. 
If not, adjust the following instructions accordingly.

The following instructions depend on you to select the appropriate serial port on the 
host - the serial port which connects to the target’s (primary) serial port. On Linux this 
could be /dev/ttyS0, while the same port on Windows would be named COM1, or 
/dev/ttya on Solaris. Substitute the proper serial port name in the below.

Connect to the target by issuing the following commands in GDB console mode:
(gdb) set remotebaud 38400    
(gdb) set mips-force-32bit-saved-gpregs
(gdb) target remote /dev/ttyS0

In Insight, connect by opening the File->Target Settings... window and enter:
Target: Remote/Serial     
Baud Rate: 38400     
Port: /dev/ttyS0

8
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Connecting To A Target Via Ethernet
You will also need to open the GDB console window with View->Console and enter 
“set mips-force-32bit-saved-gpregs” at the prompt

Set other options according to preference, close the window and select 
Run->Connect to target.

Connecting To A Target Via Ethernet
Some targets allow GDB to connect via Ethernet - if so, it will be mentioned in the 
section describing the target. Substitute the target’s assigned IP address or hostname 
for <hostname> in the following. The <port> is the TCP port which the eCos GDB 
stub or CygWin is listening on. It is also listed in the section describing the target.

Connect to the target by issuing the following command in GDB console mode:
(gdb) target remote <hostname>:<port>

In Insight, connect by opening the File->Target Settings... window and enter:
Target: Remote/TCP     
Hostname: <hostname>     
Port: <port>

Set other options according to preference, close the window and select 
Run->Connect to target.

Connecting To A Simulator Target
GDB connects to all simulator targets using the same basic command, although each 
simulator may require additional options. These are listed in the section describing the 
target, and should be used when connecting.

Connect to the target by issuing the following command in GDB console mode:
(gdb) target sim [target specific options]

In Insight, connect by opening the File->Target Settings... window and enter:
Target: Simulator     
Options: [target specific options]

Set other options according to preference, close the window and select 
Run->Connect to target.
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Connecting To A Synthetic Target
Connecting To A Synthetic Target
Synthetic targets are special in that the built tests and applications actually run as 
native applications on the host. This means that there is no target to connect to - the 
test or application can be run directly from the GDB console using:
(gdb) run

or from Insight by pressing the Run icon. There is therefore no need to connect to the 
target or download the application, so you should ignore GDB “target” and “load” 
commands in any instructions found in other places in the documentation.

ARM PID Hardware Setup
eCos comes with two ROM images that provide GDB support for the ARM PID 
board. The first ROM image provides a port of the CygMon ROM monitor, which 
includes a command-line interface and a GDB remote stub. The second ROM image 
provides a remote GDB stub only, which is a minimal environment for downloading 
and debugging eCos programs solely using GDB.

eCos, CygMon and the GDB stubs all support the PID fitted with both ARM7T and 
ARM9 daughterboards. CygMon and the stubs can be programmed into either the 
programmable ROM (U12) or the FLASH (U13). Prebuilt forms of both ROM images 
are provided in the directory loaders/arm-pid under the root of your eCos installation, 
along with a tool that will program the stubs into the FLASH memory on the board. 
CygMon images are prefixed with the name 'cygmon' and GDB stub ROM images are 
given the prefix 'gdb_module'. Images may be provided in a number of formats 
including ELF (.img extension), binary (.bin extension) and SREC (.srec extension). 
Note that some unreliability has been experienced in downloading files using Angel 
1.00. Angel 1.02 appears to be more robust in this application.

Installing the Stubs into FLASH

Preparing the Binaries
These two binary preparation steps are not strictly necessary as the eCos distribution 
ships with precompiled binaries in the directory loaders/arm-pid relative to the 
installation root.

Building the ROM images with the eCos Configuration Tool
1. Start with a new document - selecting the File->New menu item if necessary to do 

this.
eCos Getting Started with eCos ■ 37



Installing the Stubs into FLASH
2. Choose the Build->Templates menu item, and then select the ARM PID 
hardware.

3. While still displaying the Build->Templates dialog box, select either the "stubs" 
package template to build a GDB stub image, or the "cygmon" template to build 
the CygMon ROM Monitor. Click OK.

4. Build eCos using Build->Library

5. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. GDB stub ROM images have the prefix "gdb_module". CygMon 
images have the prefix "cygmon".

Building the ROM images with ecosconfig
(See “Using ecosconfig on UNIX” on page 70)

1. Make an empty directory to contain the build tree, and cd into it.

2. To build a GDB stub ROM image, enter the command:
   $ ecosconfig new pid stubs
or to build a CygMon ROM monitor image, enter the command:
   $ ecosconfig new pid cygmon

3. Enter the commands:
 $ ecosconfig tree
 $ make

4. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. GDB stub ROM images have the prefix "gdb_module". CygMon 
images have the prefix "cygmon".

Building the FLASH Tool with the eCos Configuration Tool
1. Start with a new document - selecting the File->New menu item if necessary to do 

this.

2. Choose the Build->Templates menu item, and then select the ARM PID 
hardware.

3. Enable the "Build flash programming tool" option in the ARM PID HAL 
(CYGBLD_BUILD_FLASH_TOOL) and resolve any resulting configuration 
conflicts.

4. Build eCos using Build->Library

5. When the build completes, the FLASH tool image file can be found in the bin/ 
subdirectory of the install tree, with the prefix "prog_flash"

Building the FLASH Tool with ecosconfig
(See “Using ecosconfig on UNIX” on page 70)
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Installing the Stubs into FLASH
1. Make an empty directory to contain the build tree, and cd into it

2. Enter the command:
 $ ecosconfig new pid

3. Edit the file ecos.ecc and enable the option CYGBLD_BUILD_FLASH_TOOL 
by uncommenting its user_value property and setting it to 1.

4. Enter the commands:
 $ ecosconfig resolve
[there will be some output]
 $ ecosconfig tree
 $ make

5. When the build completes, the FLASH tool image file can be found in the bin/ 
subdirectory of the install tree, with the prefix "prog_flash"

Prepare the Board for FLASH Programming
Each time a new image is to be programmed in the FLASH, the jumpers on the board 
must be set to allow Angel to run:

1. Set jumper 7-8 on LK6   [using the Angel code in the 16 bit EPROM]

2. Set jumper 5-6 on LK6   [select 8bit ROM mode]

3. Set jumper LK18         [ROM remap - this is also required for eCos]

4. Set S1 to 0-0-1-1       [20MHz operation]

5. Open jumper LK4  [enable little-endian operation]

Attach a serial cable from Serial A on the PID board to connector 1 on the 
development system. This is the cable through which the binaries will be 
downloaded. Attach a serial cable from Serial B on the PID board to connector 2 
on the development system (or any system that will work as a terminal). Through 
this cable, the FLASH tool will write its instructions (at 38400 baud).

Program the FLASH
1. Download the FLASH ROM image onto the PID board. For example. for the 

GDB stubs image:

bash$ arm-elf-gdb -nw gdb_module.img
GNU gdb 4.18-ecos-99r1-991015
Copyright 1998 Free Software Foundation, Inc.
GDB is free software, covered by the GNU General Public License, 
and you are welcome to change it and/or distribute copies of it 
under certain conditions. Type "show copying" to see the 
conditions. There is absolutely no warranty for GDB. Type "show 
warranty" for details.
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Installing the Stubs into FLASH
This GDB was configured as "--host=i586-pc-cygwin32 --target=arm-
elf".
(no debugging symbols found)...
(gdb) target rdi s=com1
Angel Debug Monitor for PID (Built with Serial(x1), Parallel, DCC) 
1.00
(Advanced RISC Machines SDT 2.10)
Angel Debug Monitor rebuilt on Jan 20 1997 at 02:33:43
Connected to ARM RDI target.
(gdb) load
Loading section .rom_vectors, size 0x44 lma 0x60000
Loading section .text, size 0x1f3c lma 0x60044
Loading section .rodata, size 0x2c lma 0x61f80
Loading section .data, size 0x124 lma 0x61fac
Start address 0x60044 , load size 8400
Transfer rate: 5169 bits/sec.
(gdb) q 
The program is running.  Exit anyway? (y or n) y 

NOTE: On a UNIX or Linux system, the serial port must be
 /dev/ttyS0 instead of COM1.
 You need to make sure that the /dev/ttyS0 files have the right permissions:

 $ su
 Password:
 # chmod o+rw /dev/ttyS0*
 # exit 

If you are programming the GDB stub image, it will now be located at 
0x60000..0x64000. If you are programming the Cygmon ROM Monitor, it will be 
located at 0x60000..0x80000.

2. Now download the FLASH programmer tool

bash$ arm-elf-gdb prog_flash.img 
GNU gdb 4.18-ecos-99r1-991015
Copyright 1998 Free Software Foundation, Inc.
GDB is free software, covered by the GNU General Public License, 
and you are     welcome to change it and/or distribute copies of it 
under certain conditions. Type "show copying" to see the 
conditions. There is absolutely no warranty for GDB.  Type "show 
warranty" for details.
This GDB was configured as "--host=i586-pc-cygwin32 --target=arm-
elf".
(gdb) target rdi s=com1
Angel Debug Monitor for PID (Built with Serial(x1), Parallel, DCC) 
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Installing the Stubs into FLASH
1.00
(Advanced RISC Machines SDT 2.10)
Angel Debug Monitor rebuilt on Jan 20 1997 at 02:33:43
Connected to ARM RDI target.
(gdb) load
Loading section .rom_vectors, size 0x44 lma 0x40000
Loading section .text, size 0x44a4 lma 0x40044
Loading section .rodata, size 0x318 lma 0x444e8
Loading section .data, size 0x1c8 lma 0x44800
Start address 0x40044 , load size 18888
Transfer rate: 5596 bits/sec.
(gdb) c

3. The FLASH tool will output some text on the board serial port B at 38400 baud:

ARM eCos
FLASH here!
manuf: 8, device: 40
Error: Wrong Manufaturer: 08
... Please change FLASH jumper

4. This text is repeated until you remove the jumper 7-8 on LK6. Then the output 
will be:

manuf: 1F, device: A4
AT29C040A recognised
About to program FLASH using data at 60000..64000
*** Press RESET now to abort!

5.  You have about 10 seconds to abort the operation by pressing reset. After this 
timeout, the FLASH programming happens:

...Programming FLASH 
All done!

6. Quit/kill the GDB process, which will hang.

7. Next time you reset the board, the stub will be in control, communicating on 
Serial A at 38400 baud.

NOTE: If you do not have two serial ports available on your host computer, you may 
still verify the flash programming completed successfully by quitting/killing 
the GDB process after running "c" in step 2 above. Then switch the serial 
cable on the PID from Serial A to Serial B and run a terminal emulator on the 
host computer. In a few seconds you should see the the repeated text 
described in step 2 above and you may continue the remaining steps as 
normal.
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Installing the Stubs into ROM
Programming the FLASH for big-endian mode
The process is almost identical to the previous instructions which apply to a PID board 
running in little-endian mode only.

The only adjustments to make are that if programming a GDB stub ROM image (or 
CygMon ROM monitor image), you must enable the option "Use Big-endian mode" in 
the eCos Configuration Tool (CYGHWR_HAL_ARM_BIGENDIAN if using 
ecosconfig and editing ecos.ecc).

When programming the FLASH there are two options:

1. Program FLASH using the little-endian FLASH tool. After powering off, replace 
the ROM controller with the special big-endian version which can be acquired 
from ARM. (This has not been tested by Red Hat).

2. Use a specied big-endian version of the FLASH tool which byte-swaps all the 
words as they are written to the FLASH.

Build this tool by enabling the "Build flash programming tool for BE images on 
LE boards" option (CYGBLD_BUILD_FLASH_TOOL_BE), resulting in a utility 
with the prefix "prog_flash_BE_image_LE_system" which should be used instead 
of "prog_flash".

Note that there is a limitation to this method: no sub-word data can be read from 
the ROM. To work around this, the .rodata section is folded into the .data section 
and thus copied to RAM before the system starts.

Given that Thumb instructions are 16 bit, it is not possible to run ROM-startup 
Thumb binaries on the PID board using this method.

When the image has been programmed, power off the board, and set jumper LK4 to 
enable big-endian operation.

Installing the Stubs into ROM
1. Program the binary image file gdb_module.bin into ROM referring to the 

instructions of your ROM programmer.

2. Plug the ROM into socket U12 and install jumper LK6 pins 7-8 to enable the 
ROM.
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ARM AEB-1 Hardware Setup
Overview

The ARM AEB-1 comes with tools in ROM. These include a simple FLASH 
management tool and the Angel® monitor. eCos for the ARM AEB-1 comes with 
GDB stubs suitable for programming into the onboard FLASH. GDB is the preferred 
debug environment for GDB, and while Angel provides a subset of the features in the 
eCos GDB stub, Angel is unsupported.

Both eCos and the stubs support both Revision B and Revision C of the AEB-1 board. 
Stub ROM images for both types of board can be found in the loaders/arm-aeb 
directory under the root of your eCos installation. You can select which board you are 
using by selecting either the aeb or aebC platform by selecting the appropriate 
platform HAL in the eCos Configuration Tool.

The GDB stub can be downloaded to the board for programming in the FLASH using 
the board’s on-board ROM monitor:

1. talk to the AEB-1 board with a terminal emulator (or a real terminal!)

2. use the board’s rom menu to download a UU-encoded version of the GDB stubs 
which will act as a ROM monitor

3. tell the board to use this new monitor, and then hook GDB up to it for real 
debugging

Talking to the Board
Connect a terminal or computer's serial port to the ARM AEB-1. On a PC with a 9-pin 
serial port, you can use the cable shipped by ARM with no modification. 

Set the terminal or terminal emulator to 9600N1 (9600 baud, no parity, 1 stop bit). 

Reset the board by pressing the little reset button on the top. You will see the 
following text: 

ARM Evaluation Board Boot Monitor 0.01 (19 APR 1998)
Press ENTER within 2 seconds to stop autoboot

Press ENTER quickly, and you will get the boot prompt: 
Boot:

Downloading the Stubs via the Rom Menu
Using the AEB-1 rom menu to download the GDB stubs from the provided ".UU" file.
NOTE This is an annotated 'terminal' session with the AEB-1 monitor:
+Boot: help
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Module is BootStrap       1.00 (14 Aug 1998)
Help is available on:
Help          Modules       ROMModules    UnPlug        PlugIn
Kill          SetEnv        UnSetEnv      PrintEnv      DownLoad
Go            GoS           Boot          PC            FlashWrite
FlashLoad     FlashErase
Boot: download c000
Ready to download. Use ’transmit’ option on terminal emulator to 
download file.
... at this point, download the ASCII file "loaders/arm-aeb/
    gdb_module.img.UU". The details of this operation differ
    depending on which terminal emulator is used. It may be
    necessary to enter "^D" (control+D) when the download completes
   to get the monitor to return to command mode. 
Loaded file gdb_module.img.bin at address 0000c000, size = 19392 

Activating the GDB Stubs
Commit the GDB stubs module to flash: 

Boot: flashwrite 4018000 C000 8000
    

Verify that the eCos/"GDB stubs" module is now added in the list of modules in the 
board: 

Boot: rommodules
    

You should see output similar to the following: 
Header   Base     Limit
04000004 04000000 040034a8 BootStrap       1.00 (14 Aug 1998) 
04003a74 04003800 04003bc0 Production Test 1.00 (13 Aug 1998) 
0400e4f4 04004000 0400e60f Angel           1.02 (12 MAY 1998) 
0401c810 04018000 0401cbc0 eCos              1.3  (27 Jan 2000) GDB 

stubs
    

Now make the eCos/"GDB stubs" module be the default monitor: 
Boot: plugin eCos

    

NOTE Since the GDB stubs are always linked at the same address (0x4018000), the 
operation of writing to the flash and selecting the stubs as default monitor is 
an idempotent operation. You can download a new set of stubs following the 
same procedure - you do not have to unregister or delete anything.

Building the GDB Stub FLASH ROM Images
Prebuilt GDB stubs images are provided in the directory loaders/arm-aeb relative to 
the root of your eCos installation, but here are instructions on how to rebuild them if 
you should ever need to.

Building the GDB Stubs with the eCos Configuration 
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Building the GDB Stub ROMs with ecosconfig
Tool
1. Start with a new document - selecting the File->New menu item if necessary to do 

this.

2. Choose the Build->Templates menu item, and then select the ARM AEB-1 
hardware.

3. While still displaying the Build->Templates dialog box, select the "stubs" 
package template to build a GDB stub image. Click OK.

4. If applicable, set the "AEB board revision" option to "C" from "B" depending on 
the board revision being used.

5. Build eCos using Build->Library.

6. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. The GDB stub ROM images have the prefix "gdb_module".

Building the GDB Stub ROMs with ecosconfig
(See “Using ecosconfig on UNIX” on page 70)

1. Make an empty directory to contain the build tree, and cd into it.

2. To build a GDB stub ROM image, enter the command:
 $ ecosconfig new aeb stubs

3. If applicable, edit ecos.ecc and set the AEB board revision. 
(CYGHWR_HAL_ARM_AEB_REVISION) from the default "B" to "C" by 
uncommenting the user_value property and setting it to "C".

4. Enter the commands
 $ ecosconfig tree
 $ make

5. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. The GDB stub ROM images have the prefix "gdb_module".

ARM Cogent CMA230 Hardware 
Setup

The eCos Developer’s Kit package comes with an EPROM which provides GDB 
support for the Cogent evaluation board. An image of this EPROM is also provided at 
loaders/arm-cma230/gdbload.bin under the root of your eCos installation. 

The EPROM is installed to socket U3 on the board. Attention should be paid to the 
correct orientation of the EPROM during installation.
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If you are going to burn a new EPROM using the binary image, be careful to get the 
byte order correct. It needs to be little-endian, which is usually the default in PC based 
programmer software.

If the GDB stub EPROM you burn does not work, try reversing the byte-order, even if 
you think you have it the right way around. At least one DOS-based EPROM burner 
program is known to have the byte-order upside down.

The GDB stub in the EPROM allows communication with GDB using the serial port 
at connector P12 (CMA101) or P3 (CMA102). The communication parameters are 
fixed at 38400 baud, 8 data bits, no parity bit and 1 stop bit (8-N-1).  No flow control 
is employed. Connection to the host computer should be made using a dedicated serial 
cable as specified in the Cogent CMA manual.

Building the GDB Stub FLASH ROM images
Prebuilt GDB stubs images are provided in the directory loaders/arm-cma230 relative 
to the root of your eCos installation, but here are instructions on how to rebuild them if 
you should ever need to.

CygMon images are prefixed with the name ’cygmon’ and GDB stub ROM images

are given the prefix ’gdb_module’. Images may be provided in a number of formats 
including ELF (.img extension), binary (.bin extension) and SREC (.srec extension). 

Building the GDB Stubs with the eCos Configuration Tool
1. 1. Start with a new document - selecting the File->New menu item if

necessary to do this.

2. Choose the Build->Templates menu item, and then select the ARM CMA230 
hardware.

3. While still displaying the Build->Templates dialog box, select the "stubs" 
package template to build a GDB stub image. Click OK.

4. Build eCos using Build->Library

5. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. The GDB stub ROM images have the prefix "gdb_module".

Building the GDB Stub ROMs with ecosconfig
(See “Using ecosconfig on UNIX” on page 70)

1. 1. Make an empty directory to contain the build tree, and cd into it.

2. To build a GDB stub ROM image, enter the command:
 $ ecosconfig new cma230 stubs
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3. Enter the commands:
 $ ecosconfig tree
 $ make

4. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. The GDB stub ROM images have the prefix "gdb_module".

Cirrus Logic ARM EP7211 
Development Board Hardware Setup

eCos comes with two Flash ROM images that provide GDB support for the Cirrus 
Logic EP7211 Development Board (also known as the EDB7211).. Note that on some 
board revisions, the board is silk-screened as EDB7111-2. The first Flash ROM image 
provides a port of the CygMon ROM monitor, which includes a command-line 
interface and a GDB remote stub. The second Flash ROM image provides a remote 
GDB stub only.

Both ROM images are provided in the directory loaders/arm-edb7211 under the root 
of your eCos installation. CygMon images are prefixed with the name 
’edb7211_cygmon’ and are provided in a number of formats including binary (.bin 
extension) and SREC (.srec) extension. GDB stub ROM images are given the prefix 
’edb7211_gdb_module’. 

The ROM images provided for the EP7211 Development Board must be programmed 
into the flash. Please refer to the section titled "Loading the ROM image into On-
Board flash" on how to program the ROM onto the board.

Both Cygmon and GDB Stub ROMS allow communication with GDB via the serial 
connector labelled ’UART 1’. The communication parameters are fixed at 38400 baud, 
8 data bits, no parity bit and 1 stop bit (8-N-1). No flow control is employed. 
Connection to the host computer should be made using a null modem cable. A gender 
changer may also be required. Note that the GDB Configuration tool uses the serial 
port identifiers 0 and 1 to identify the EB7211 serial ports UART1 and UART2 
respectively.

Both eCos and the ROM images assume the core clock is generated with a 3.6864 
MHz PLL input. The CPU will be configured to run at 73.728MHz.

Note: The EP7211 CPU needs a two step RESET process. After pressing the 
‘URESET’ pushbutton, the ‘WAKEUP’ pushbutton must be pressed to complete the 
process.
NOTE When an eCos program is run on an EDB7211 board fitted with either 

CygMon or a GDB stub ROM, then the code in ROM loses control. This 
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means that if you require the ability to remotely stop execution on the target, 
or want thread debugging capabilities, you must include GDB stub support 
when configuring eCos.

Building programs for programming into flash
If your application is to be run directly from flash, you must configure eCos 
appropriately for "ROM" startup. This can be done in the eCos Configuration Tool 
by setting the "Startup type" HAL option to "ROM". If using the ecosconfig utility, set 
the user_value of the CYG_HAL_STARTUP option in ecos.ecc to "ROM".

When you have linked your application with eCos, you will then have an ELF 
executable. To convert this into a format appropriate for the Cirrus Logic flash 
download utility, or the dl_7xxx utility on linux, you can use the utility arm-elf-
objcopy, as in the following example:
   $ arm-elf-objcopy -O binary helloworld.exe helloworld.bin

This will produce a binary format image helloworld.bin which can be downloaded 
into flash.

Building the GDB Stub FLASH ROM images
Prebuilt GDB stubs images are provided in the directory loaders/arm-edb7211 relative 
to the root of your eCos installation, but here are instructions on how to rebuild them if 
you should ever need to.

CygMon images are prefixed with the name ’cygmon’ and GDB stub ROM images are 
given the prefix ’gdb_module’. Images may be provided in a number of formats 
including ELF (.img extension), binary (.bin extension) and SREC (.srec extension). 

Building the ROM images with the eCos Configuration Tool
1. Start with a new document - selecting the File->New menu item if

necessary to do this.

2. Choose the Build->Templates menu item, and then select the "Cirrus Logic 
development board" hardware.

3. While still displaying the Build->Templates dialog box, select either the "stubs" 
package template to build a GDB stub image, or the "cygmon" template to build 
the CygMon ROM Monitor. Click OK.

4. Build eCos using Build->Library

5. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. GDB stub ROM images have the prefix "gdb_module". CygMon 
images have the prefix "cygmon".
48 ■ Getting Started with eCos eCos



Loading the ROM Image into On-board Flash
Building the ROM images with ecosconfig
(See “Using ecosconfig on UNIX” on page 70)

1. Make an empty directory to contain the build tree, and cd into it.

2. To build a GDB stub ROM image, enter the command:
 $ ecosconfig new edb7xxx stubs
or to build a CygMon ROM monitor image, enter the command:
 $ ecosconfig new edb7xxx cygmon

3. Enter the commands:
 $ ecosconfig tree
 $ make

4. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. GDB stub ROM images have the prefix "gdb_module". CygMon 
images have the prefix "cygmon".

Loading the ROM Image into On-board Flash
Program images can be written into Flash memory by means of a bootstrap program 
which is built into the  EDB7211.  This program communicates with a support 
program on your host to download and program an image into the Flash memory.

Cirrus Logic provides such a program for use with Windows/DOS.  eCos comes with 
a similar program which will run under Linux. The basic operation of both programs 
is the same.

1. Connect a serial line to 'UART 1'.

2. Power off the  EDB7211.

3. Install jumper 'PROGRAM ENABLE' which enables this special mode for 
downloading Flash images. Note that some board revisions have this jumper 
labelled “BOOT ENABLE”.

4. Power on the  EDB7211.

5. Execute the Flash writing program on your host.  On Linux, this would be:

     # dl_edb7xxx <PATH>/gdb_module.bin

where '<PATH>' is the path to the binary format version of the ROM image you 
wish to load, either as built in the previous section or the "loaders/arm-edb7211/" 
subdirectory of your eCos installation. The download tool defaults to 38400 baud 
and device /dev/ttyS1 for communication. To change these, specify them as 
parameters, e.g.

# dl_edb7xxx <PATH>/gdb_module.bin 9600 /dev/ttyS0
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6. The download program will indicate that it is waiting for the board to come alive.  
At this point, press ’RESET’ and then ’WAKEUP’ switches in order.  There should 
be some indication of progress, first of the code being downloaded, then of the 
programming process.

7. Upon completion of the programming, power off the  EDB7211.

8. Remove the ’PROGRAM ENABLE/BOOT ENABLE’ jumper.

9. Power on the  EDB7211, press ’RESET’ and ’WAKEUP’.  The new ROM image 
should now be running on the board.

10. The GDB debugger will now be able to communicate with the board to download 
and debug RAM based programs.

This procedure also applies for loading ROM-startup eCos programs into the on-
board flash memory, given a binary format image of the program from arm-elf-
objcopy.  Loading a ROM-startup eCos program into Flash will overwrite the 
GDB Stub ROM/CygMon in Flash, so you would have to reload the GDB Stub 
ROM/CygMon to return to normal RAM-startup program development.

Building the Flash Downloader on Linux
eCos provides a Flash download program suitable for use with the  EP7211 
Development Board which will run on Linux.  Follow these steps to build this 
program.  Note: at the time of the writing of these instructions, the download program 
is built directly within the eCos source repository since it is not configuration specific.
  # cd <eCos install dir>/packages/hal/arm/edb7xxx/v1_3_1/support
  # make

(where ’# ’ is your shell prompt)

Note: this program was adapted from the Cirrus Logic original DOS program and still 
contains some vestiges of that environment.

Developing eCos Programs with the ARM Multi-ICE
The EP7211 Development Board supports use of the ARM Multi-processor 
EmbeddedICE(tm), also known as the Multi-ICE. Full instructions on how to install 
and use the Multi-ICE in conjunction with GDB are provided in the "GNUPro Toolkit 
Reference for eCos ARM/Thumb" manual. However, the following platform-specific 
details should be noted.

You will need an ARM Multi-ICE Server configuration file for the EP7211 
Development Board. Here is a suggested configuration file to use:
======== File "720T.cfg" ======== 
;Total IR length = 4 
[TITLE] 
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Developing eCos Programs with the ARM Multi-ICE
Multi-ICE configuration for EP7211 
 
[TAP 0] 
ARM720T 
 
[TAPINFO] 
YES 
 
[Timing] 
Low=0 
High=0 
Adaptive=OFF 
==================================

You must ensure that the board has the appropriate soldered connections. For the 
EP7211 this involves connecting TEST0 and TEST1 of the EP7211 to ground. To do 
this you must solder a wire from ground at JP33 to TP8 and TP9.

With respect to using multiple devices simultaneously, note that the EP7211 is not ID 
sensitive.

If you wish to view diagnostic output from your program that was downloaded via the 
Multi-ICE, you will note that by default the output on the serial line (as viewed by a 
terminal such as Hyperterm in Windows, or cu in Unix) is in the form of GDB 
packets.

To get legible output, the solution is to set the "GDB Serial port" to a different device 
from the "Diagnostic serial port", and you should use the Diagnostic serial port to 
view the diagnostic output.

Warning: The multi-ice-gdb-server will fail on startup if the board has not been both 
reset and awakened before running the server. 

To resolve this, it is necessary to free up the connection from within the ARM Multi-
ICE server itself. However when this happens, the next time you use GDB to load the 
program into the board, you will see lots of "Readback did not match original data" 
messages in the output of the multi-ice-gdb-server program. This indicates your 
program did not load correctly, and you should restart the multi-ice-gdb-server 
program, taking care to reset the board correctly before reconnecting. 

As a reminder, you must specify --config-dialog to the multi-ice-gdb-server program 
to connect to the board correctly. If you do not, the multi-ice-gdb-server program will 
not be able to connect.
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Cirrus Logic ARM EP7212 
Development Board Hardware Setup

The Cirrus Logic EP7212 Development Board is almost identical to the EP7211 
Development Board from a hardware setup viewpoint, and is based on the same port 
of eCos. Therefore the earlier documentation for the EP7211 Development Board can 
be considered equivalent, but with the following changes:

■ The first serial port is silk screened as "UART 1" on the EP7211 Development 
Board, but is silk screened as "Serial Port 0" on the EP7212 Development Board. 
Similarly "UART 2" is silk screened as "Serial Port 1" on the EP7212 
Development Board.

■ JP2 (used to control reprogramming of the flash) is not silkscreened with "Boot 
Enable".

■ To setup the EP7212 Development Board for use with the ARM Multi-ICE JTAG 
debugging interface unit, it is necessary to connect TEST0 and TEST1 of the 
EP7212 to ground.  On the Development Board, this is accomplished by placing 
shorting blocks on JP47 and JP48. When the shorting blocks are fitted, the board 
can only be operated through the Multi-ICE - debugging over a serial line is not 
possible.

■ Prebuilt GDB stubs are provided in the directory loaders/arm-edb7212 relative to 
the root of your eCos installation

■ When rebuilding the GDB stub ROM image, change the "Cirrus Logic processor 
variant" option (CYGHWR_HAL_ARM_EDB7XXX_VARIANT) from the 
EP7211 to the EP7212. This can be selected in the eCos Configuration Tool, or if 
using ecosconfig, can be set by uncommenting the user_value property of this 
option in ecos.ecc and setting it to "EP7212".

Cirrus Logic ARM EP7209 
Development Board Hardware Setup

Note: At time of writing, no EP7209 Development Board is available, and 
consequently eCos has not been verified for use with the EP7209 Development Board.

The Cirrus Logic EP7209 Development Board is almost identical to the EP7212 
Board in all respects, except that it is not fitted with DRAM, nor has it a DRAM 
controller.
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The only valid configuration for the EDB7209 is ROM based. The STUBS and RAM 
startup modes are not available as no DRAM is fitted.

Cirrus Logic ARM CL-PS7111 
Evaluation Board Hardware Setup

The implementation of the port of eCos to the Cirrus Logic ARM CL-PS7111 
Evaluation Board (also known as EB7111) is based on the EP7211 Development 
Board port.

For that reason, the setup required is identical to the  EP7211 Development Board as 
described above, with the following exceptions:

■ The Cygmon ROM monitor is not supported

■ The ARM Multi-ICE is not supported

■ Prebuilt GDB stubs are provided in the directory loaders/arm-eb7111 relative to 
the root of your eCos installation

■ If rebuilding the GDB stub ROM image, change the "Cirrus Logic processor 
variant" option (CYGHWR_HAL_ARM_EDB7XXX_VARIANT) from the 
EP7211 to the CL_PS7111. This can be selected in the eCos Configuration Tool, 
or if using ecosconfig, can be set by uncommenting the user_value property of 
this option in ecos.ecc and setting it to "CL_PS7111"

■ All remote serial communication is done with the serial I/O connector labelled 
’Serial Port 1’

StrongARM EBSA-285 Hardware 
Setup

The eCos Developer’s Kit package comes with a ROM image which provides GDB 
support for the Intel® StrongARM® Evaluation Board EBSA-285.  Both eCos and 
the Stub ROM image assume the clocks are: 3.6864 MHz PLL input for generating the 
core clock, and 50MHz osc input for external clocks. An image of this ROM is also 
provided at loaders/arm-ebsa285/gdbload.bin under the root of your eCos 
installation.
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The ROM monitor image (an eCos GDB stub) provided for the EBSA-285 board must 
be programmed into the flash, replacing the Angel monitor on the board. Please refer 
to the section titled "Loading the ROM Image into On-Board flash" on how to 
program the ROM onto the board.

The Stub ROM allows communication with GDB via the serial connector on the 
bulkhead mounting bracket COM0.  The communication parameters are fixed at 
38400 baud, 8 data bits, no parity bit and 1 stop bit (8-N-1).  No flow control is 
employed.

Building the GDB Stub FLASH ROM images
Prebuilt GDB stubs images are provided in the directory loaders/arm-ebsa285 relative 
to the root of your eCos installation, but here are instructions on how to rebuild them if 
you should ever need to.

Building the GDB Stubs with the eCos Configuration Tool
1. Start with a new document - selecting the File->New menu item if necessary to do 

this.

2. Choose the Build->Templates menu item, and then select the StrongARM 
EBSA285 hardware.

3. While still displaying the Build->Templates dialog box, select the "stubs" 
package template to build a GDB stub image. Click OK.

4. Build eCos using Build->Library

5. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. The GDB stub ROM images have the prefix "gdb_module".

Building the GDB Stub ROMs with ecosconfig
(See “Using ecosconfig on UNIX” on page 70)

1. Make an empty directory to contain the build tree, and cd into it.

2. To build a GDB stub ROM image, enter the command:
 $ ecosconfig new ebsa285 stubs

3. Enter the commands:
 $ ecosconfig tree
 $ make

4. When the build completes, the image files can be found in the bin/ subdirectory of 
the install tree. The GDB stub ROM images have the prefix "gdb_module".
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Loading the ROM Image into On-board Flash
There are several ways to install the eCos gdb stub ROM image in the EBSA board’s 
flash memory. Once installed, the gdb stub ROM provides standard eCos download 
and debug via the EBSA board's serial port. The options available include the Linux 
based EBSA flash upgrade utility provided by Red Hat, direct writing of the flash via 
MultiICE (JTAG) hardware debugger, and other flash management utilities from Intel 
(these only support DOS, and proprietary ARM tools and image formats). Only the 
Red Hat flash upgrade tool is supported and tested in this release.

The flash upgrade tool requires the EBSA board to be configured as a PCI slave 
(rather than a master, its normal operating mode) and plugged into a Linux host 
computer's PCI bus.

Configuring the board for flash loading: Follow the instructions in the EBSA-285 
Reference Manual, pages A-2 and A-3 to configure the board as an add-in card, and 
enable flash blank programming.  Briefly: assuming the board was in the default 
setting to execute as a bus master ("Host Bridge") make jumper 9 (J9), move jumper 
10 (J10) to external reset (PCI_RST), and move jumper 15 (J15) link 4-6-5 to connect 
5-6 instead of 4-6.

Configuring the board for execution of eCos programs: Follow the instructions in the 
EBSA-285 Reference Manual, pages A-2 and A-3 to configure the board as a "Host 
Bridge" with "Central Function".  Briefly: unset J9, move J10 to on-board reset 
(BRD_RST), and set J15 to make 4-6 instead of 5-6 (see page A-8 also).  Plug the card 
into its own PCI bus, not the Linux PC used for the flash-programming process.

Building the Linux software: the Linux software sources are in directory
      <BASEDIR>/packages/hal/arm/ebsa285/v1_3/support/linux/
safl_util

in the eCos source repository.  There are two parts to the system: a loadable kernel 
module and the flash utility.  The loadable kernel module is safl.o and the utility is 
sa_flash.  To build:

  cd to this directory, or a copy of it.

  make

This builds safl.o and sa_flash. The kernel module must be installed, and a device file 
created for it. Both of these operations require root permissions.  Create the device file 
by: 
      % mknod /dev/safl c 10 178

Programming the flash: switch off the EBSA-285, and remove the EBSA-285 board 
from its PCI bus.  Take appropriate anti-static precautions. Configure it for flash 
loading as above, halt your Linux system and turn it off.  Install the EBSA-285 board 
in the PCI bus of the Linux system and boot it up. (Single user is good enough, 
eCos Getting Started with eCos ■ 55



i386/Linux Synthetic Target Setup
assuming your image and safl_util build dir are on a local disc partition.)  Change 
directory to the safl_util directory, then, to load the kernel module and flash an image 
onto the eval board (as root): 
       % insmod safl.o
       % sa_flash <image_file>

Halt and turn off the Linux machine and remove the EBSA-285 card.  Take 
appropriate anti-static precautions.  Configure it for execution of eCos programs as 
above, and plug it into its own PCI bus.  Restart the Linux machine however you wish.

This information is replicated in the README file within the safl_util directory and 
its parents, and in the EBSA-285 Reference Manual from Intel, appendix A 
"Configuration Guide".  If in doubt, please refer to those documents also.

This procedure also applies for loading ROM-startup eCos programs into the on-board 
flash memory, given a binary format image of the program from arm-elf-objcopy.  
Loading a ROM-startup eCos program into flash will overwrite the StubROM in flash, 
so you would have to reload the StubROM to return to normal RAM-startup program 
development.

i386/Linux Synthetic Target Setup
When building for the synthetic Linux target, the resulting binaries are native Linux 
applications with the HAL providing suitable bindings between the eCos kernel and 
the Linux kernel.
NOTE: Please be aware that the current implementation of the Linux synthetic target 

does not allow thread-aware debugging.

These Linux applications cannot be run on a Windows system. However, it is possible 
to write a similar HAL emulation for the Windows kernel if such a testing target is 
desired.

Tools
For the synthetic target, eCos relies on features not available in native compilers 
earlier than gcc-2.95.1. It also requires version 2.9.5 or later of the GNU linker. If you 
have gcc-2.95.1 or later and ld version 2.9.5 or later, then you do not need to build 
new tools. eCos does not support earlier versions. You can check the compiler version 
using gcc -v or egcs -v, and the linker version using ld -v.

If you have native tools that are sufficiently recent for use with eCos, you should be 
aware that by default eCos assumes that the tools i686-pc-linux-gnu-gcc, i686-pc-
linux-gnu-ar,  i686-pc-linux-gnu-ld, and i686-pc-linux-gnu-objcopy are on your 
system and are the correct versions for use with eCos. But instead, you can tell eCos to 
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use your native tools by editting the configuration value "Global command prefix" 
(CYGBLD_GLOBAL_COMMAND_PREFIX) in your eCos configuration. If left 
empty (i.e. set to the empty string) eCos will use your native tools when building.

If you have any difficulties, it is almost certainly easiest overall to rebuild the tools as 
described on:

http://sourceware.cygnus.com/ecos/getstart.html
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Tools
Running Applications on the 
Target

To verify both that a hardware target is properly set up, and that the GDB commands 
used to connect to the target (hardware, simulator or synthetic) work properly on your 
system, you will now be guided  through “downloading” and executing a prebuilt 
eCos test. The procedure is exactly the same when you want to download and run 
applications or tests that you have built yourself.

On Windows you must have the bash command line interpreter running with some 
environment variables which are useful for eCos work. If you have purchased the 
eCos Developer’s Kit, you can select this by selecting Start->Programs->Red Hat 
eCos->eCos Development  Environment. If you are using the eCos Net release, you  
should set the environment variables as shown in the GNUPro Toolkit Reference 
Manual. On Linux, simply open a new shell window.

You will need to change directory to the prebuilt tests that are provided in the eCos 
installation. Change directory as follows:
for the SHARP LH77790A-based AEB-1 boards:
  $ cd BASE_DIR/prebuilt/aeb/tests/kernel/v1_3_1/tests
for the ARM7-based Cogent CMA230 board:
  $ cd BASE_DIR/prebuilt/cma230/tests/kernel/v1_3_1/tests
for the StrongARM based Intel EBSA board:
  $ cd BASE_DIR/prebuilt/ebsa285/tests/kernel/v1_3_1/tests
for the ARM-based Cirrus Logic EP72xx Development boards:
  $ cd BASE_DIR/prebuilt/edb7xxx/tests/kernel/v1_3_1/tests
for the ARM-based ARM PID board:
  $ cd BASE_DIR/prebuilt/pid/tests/kernel/v1_3_1/tests
for the i386-based Linux synthetic target:
  $ cd BASE_DIR/prebuilt/linux/tests/kernel/v1_3_1/tests

9
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To execute the thread_gdb test case on the desired target, run GDB in command line 
mode using the following command, remembering to substitute the appropriate name 
for the architecture’s gdb:     
$ gdb -nw thread_gdb

GDB will display a copyright banner and then display a prompt (gdb). Connect to the 
target according to the instructions given earlier (in “Target Setup” on page 35) - via 
serial or ethernet to hardware  targets, or directly for simulator and synthetic targets. 

Depending on the target type, you will be notified about a successful  connection, and 
possibly see some output informing you of the current program counter of the target.

Now download the test - effectively loading the test case executable  into the memory 
of the target - by typing this command:
(gdb) load

Again, depending on the target, you may see some output describing how much data 
was downloaded, and at what speed. Next, start the test case running. For hardware 
targets this is done with the ‘continue’ command, while ‘run’ must be used on 
simulators and synthetic  targets:
(gdb) continue

 or
(gdb) run

You should now see a number of text messages appear, such as: 
PASS:<GDB Thread test OK>    
EXIT:<done>

NOTE eCos has no concept of the application exiting. All eCos test cases complete 
and then run in a continuous tight loop. To return control to GDB you must 
stop the application.

NOTE When an eCos program is run on ARM or SH3 boards, the GDB stub in ROM 
does not provide thread debugging or asynchronous GDB interrupt support. If 
you require full debugging capabilities, you must include GDB stub support 
when configuring eCos.

The usual method of stopping an application is with Ctrl+C, but Ctrl+C may  not 
work on your platform for the prebuilts. First, make default tests and check that they 
work the same way as prebuilts, then modify your config to enable GDB stubs (if 
applicable) and break support, so that a Ctrl+C character will interrupt the 
application.

Another way to stop the application is by means of a breakpoint. Before running the 
application, breakpoint  cyg_test_exit() to stop an eCos test case at its end.

The full functionality of GDB is now available to you, including breakpoints and 
watchpoints. Please consult the GNUPro GDB documentation for further information.
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Part III: Programming Tutorial
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The Development Process
Programming with eCos

The remaining chapters of this document compromise a simple tutorial for 
configuring and building eCos, building and running eCos tests, and finally building 
three stand-alone example programs which use the  eCos API to perform some simple 
tasks.

You will need a properly installed eCos system, with the accompanying versions of 
the GNUPro tools. On Windows you will be using the bash command line interpreter 
that comes with Cygwin, with the environment variables set as described in the 
GNUPro documentation.

The Development Process
Most development projects using eCos would contain some (or most) of  the 
following:

eCos Configuration
eCos is configured to provide the desired API (the inclusion of libc, uitron, and the 
disabling certain undesired funtions, etc.), and semantics (selecting scheduler, mutex 
behavior, etc.). See “Configuring and Building eCos from Source” on page 64.

It would normally make sense to enable eCos assertion checking at this time as well, 
to catch as many programming errors during the development phase as possible.

Note that it should not be necessary to spend much time on eCos configuration 
initially. It may be important to perform fine tuning to reduce the memory footprint 
and to improve performance when the product reaches a testable state.

10
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    Integrity check of the eCos configuration
While Red Hat strive to thoroughly test eCos, the vast number of configuration 
permutations mean that the particular configuration parameters used for your project 
may not have been tested.

Therefore, we advise running all the eCos tests after the project’s eCos configuration 
has been determined. See “Test Suites” on page 76.

Obviously, this should be repeated if the configuration changes later on in the 
development process.

    Application Development - Target Neutral Part
While your project is probably targeting a specific architecture and platform, possibly 
custom hardware, part of the application development may be possible to do using 
simulated or synthetic targets.

There are two primary reasons for doing this:

■ It may be possible (to some extent) to perform application development in parallel 
with the design/implementation of the target hardware, thus providing more time 
for developing and testing functionality, and reducing time-to-market.

■ The build-run-debug-cycle may be faster when the application does not have to be 
downloaded to a target via a serial interface. Debugging is also likely to be more 
responsive when not having to communicate with a stub via serial. And finally, it 
also removes the need for manually or automatically resetting the target hardware.

This is possible to do since all targets (including simulators and synthetic ones) 
provide the same basic API: that is, kernel, libc, libm, uitron, infra, and to some 
extent, HAL and IO.

Synthetic targets are especially suitable as they allow you to jury-rig simulations of 
elaborate devices by interaction with the host system, where an IO device API can 
hide the details from the application. When switching to hardware later in the 
development cycle, the IO driver is properly implemented. While this is possible to 
do, and has been done, it is not specifically documented or supported by Red Hat. It 
may become so later.

Therefore, select a simulator or synthetic target and use it for as long as possible doing 
application development. That is, configure for the selected target, build eCos, build 
the application and link with eCos, run and debug. Repeat the latter two steps.

Obviously, at some time you will have to switch to the intended target hardware, for 
example when adding target specific feature support, for memory footprint/
performance characterization, and for final tuning of eCos and the application.
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The Development Process
    Application Development - Target Specific Part
Repeat the build-run-debug-cycle while performing final tuning and debugging of 
application. Remember to disable eCos assertion checking,  as it reduces performance.

It may be a useful to switch between this and the previous step repeatedly through the 
development process; use the simulator/synthetic target for actual development, and 
use the target hardware to continually check memory footprint and performance. 
There should be little cost in switching between the two targets when using two 
separate build trees. 
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eCos Start-up Configurations
Configuring and Building eCos 
from Source

This chapter documents the configuration of eCos, using the ARM PID board as an 
example. The process is the same for any of the other supported targets: you may 
select a hardware target (if you have a board available), any one of the simulators, or a 
synthetic target (if your host platform has synthetic target support).

At the end of the chapter is a section describing special issues for this architecture 
which may affect the way you should configure eCos for your target.

eCos Start-up Configurations
There are various ways to download an executable image to a target board, and these 
involve different ways of preparing the executable image. In the eCos Hardware 
Abstraction Layer (HAL package) there are configuration options to support the 
different download methods. The following table summarizes the ways in which an 
eCos image can be prepared for different types of download. 

Table 1: Configuration for various download methods

11

Download method HAL configuration

Burn hardware ROM ROM start-up

Download to ROM emulator ROM start-up
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Using the Configuration Tool on Windows
CAUTION You cannot run an application configured for RAM start-up on the simulator 
directly: it will fail during start-up. You can only download it to the simulator 
if :

■ you are already running CygMon (or a GDB stub) in the simulator, as 
described in the GNUPro documentation

NOTE Configuring eCos’ HAL package for simulation should rarely be needed for 
real development; binaries built with such a kernel will not run on target 
boards at all. The main use for a “simulation” configuration is if you are 
trying to work around problems with the device drivers or with the simulator. 

If your chosen architecture does not have simulator support, then the 
combinations above that refer to the simulator do not apply. Similarly, if your 
chosen platform does not have CygMon or GDB stub ROM support, the 
combinations listed above that use CygMon or GDB stub ROMs do not apply.

The debugging environment for most developers will be either a hardware board or 
the simulator, in which case they will be able to select a single HAL configuration.

More information on the interactions between CygMon, the simulators, and GDB’s 
thread-aware debugging features is available in the GNUPro Reference Manual for 
your specific architecture. 

Using the Configuration Tool on 
Windows

 Note that the use of the Configuration Tool is described in detail in the eCos User’s 
Guide.

The Configuration Tool (see Figure 1) has five main elements: the configuration 
window, the properties window, the short description window, the memory layout 
window, and the output window.

Download to board with CygMon or 
GDB stub ROM

RAM start-up

Download to simulator without CygMon 
or GDB stub ROM

ROM start-up

Download to simulator with CygMon RAM start-up

Download to simulator ignoring devices SIM configuration

Run synthetic target RAM start-up

Download method HAL configuration
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Figure 1: Configuration Tool

Start by opening the templates window via Build->Templates. Select the desired 
target (see Figure 2).

Figure 2: Template selection
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Using the Configuration Tool on Windows
Make sure that the configuration is correct for the target in terms of endianness, CPU 
model, Startup type, etc. (see Figure 3 ).

Figure 3: Configuring for the target

Next, select the Build->Library menu item to start building eCos (see  Figure 4).

Figure 4: Selecting the build Library menu item
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The Save As dialog box will appear, asking you to specify a directory in which to 
place your save file. You can use the default, but it is a good idea to make a 
subdirectory, called ecos-work for example. 

Figure 5: Build dialog

The first time you build an eCos library for a specific architecture, the Configuration 
Tool may prompt you for the location of the appropriate build tools (including make 
and gcc) using a Build Tools dialog box (as shown in Figure 6, page 68). You can 
select a location from the drop down list, browse to the directory using the Browse 
button, or type in the location of the build tools manually.

Figure 6: Build tools dialog

The Configuration Tool may also prompt you for the location of the user tools (such 
as cat and ls) using a User Tools dialog box (as shown in Figure 7, page 69). As with 
the Build Tools dialog, you can select a location from the drop down list, browse to 
the directory using the Browse button, or type in the location of the user tools 
manually.
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Using the Configuration Tool on Windows
Figure 7: User tools dialog

When the tool locations have been entered, the Configuration Tool will configure the 
sources, prepare a build tree, and build the libtarget.a library, which contains the eCos 
kernel and other packages.

The output from the configuration process and the building of libtarget.a will be 
shown in the output window. 

Once the build process has finished you will have a kernel with other packages in 
libtarget.a. You should now build the eCos tests for your particular configuration. 

You can do this by selecting Build -> Tests. Notice that you could have selected Tests 
instead of Library in the earlier step and it would have built both the library and the 
tests, but this would increase the build time substantially, and if you do not need to 
build the tests it is unnecessary.

Figure 8: Selecting the build tests menu item

“Test Suites” on page 76 will guide you through running one of the test cases you just 
built on the selected target, using GDB. 
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Using ecosconfig on UNIX
On UNIX systems the Configuration Tool is not yet available, but it is still possible 
to configure and build a kernel by editing a configuration file manually and using the 
ecosconfig command. 

Before invoking ecosconfig you need to choose a directory in which to work. For the 
purposes of this tutorial, the default path will be BASE_DIR/ecos-work. Create this 
directory and change to it by typing: 
$ mkdir BASE_DIR/ecos-work
$ cd BASE_DIR/ecos-work

It is also necessary to specify the location of the source repository:
$ ECOS_REPOSITORY=/opt/ecos/ecos-1.3.1/packages 
$ export ECOS_REPOSITORY

for sh/ksh/bash users; or
% setenv ECOS_REPOSITORY BASE_DIR/packages

for csh/tcsh users.

Finally, make sure the tools necessary to build eCos are available from your PATH.

For tools installed with the eCos packages (ecosconfig and ser_filter) - the default 
RPM installation path is shown - replace as necessary:
$ PATH=/opt/ecos/ecos-1.3.1/tools/bin:$PATH

For the path for the compiler and debugger tools, the path used in the build 
instructions is used - replace with the actual path you chose:
$ PATH=/install/H-i686-pc-linux-gnu/bin:$PATH
$ export PATH

csh/tsch users should do this instead:
% set PATH /opt/ecos/ecos-1.3.1/tools/bin:$path
% set PATH /install/H-i686-pc-linux-gnu/bin:$path

To see what options can be used with ecosconfig, type: 
$ ecosconfig --help

The available packages, targets and templates may be listed as follows:
$ ecosconfig list

Here is sample output from ecosconfig showing the usage message.

Table 2: Getting help from ecosconfig
$ ecosconfig --help
Usage: ecosconfig [ qualifier ... ] [ command ]

commands are:
list : list repository contents
new TARGET [ TEMPLATE [ VERSION ] ] : create a configuration
target TARGET : change the target hardware
template TEMPLATE [ VERSION ] : change the template
70 ■ Getting Started with eCos eCos



Using ecosconfig on UNIX
add PACKAGE [ PACKAGE ... ] : add package(s)
remove PACKAGE [ PACKAGE ... ] : remove package(s)
version VERSION PACKAGE [ PACKAGE ... ] : change version of package(s)
export FILE : export minimal config info
import FILE : import additional config info
check : check the configuration
resolve : resolve conflicts
tree : create a build tree

qualifiers are:
--config=FILE : the configuration file
--prefix=DIRECTORY : the install prefix
--srcdir=DIRECTORY : the source repository

    --no-resolve                               : disable conflict resolution
--version : show version and copyright

$

Table 3: ecosconfig output — list of available packages, targets and 
templates

$ ecosconfig list
Package CYGPKG_CYGMON (CygMon support via eCos):
 aliases: cygmon
 versions: v1_3_1
Package CYGPKG_DEVICES_WALLCLOCK (Wallclock device code):
 aliases: wallclock devices_wallclock device_wallclock
 versions: v1_3_1
Package CYGPKG_DEVICES_WATCHDOG (Watchdog device code):
 aliases: watchdog devices_watchdog device_watchdog
 versions: v1_3_1
Package CYGPKG_ERROR (Common error code support):
 aliases: error errors
 versions: v1_3_1
Package CYGPKG_HAL (eCos common HAL):
 aliases: hal hal_common
 versions: v1_3_1
Package CYGPKG_HAL_ARM (ARM common HAL):
 aliases: hal_arm arm_hal arm_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_ARM_AEB (ARM evaluation board (AEB-1)):
 aliases: hal_arm_aeb arm_aeb_hal
 versions: v1_3_1
Package CYGPKG_HAL_ARM_CMA230 (Cogent CMA230/222 board):
 aliases: hal_arm_cma230 arm_cma230_hal
 versions: v1_3_1
Package CYGPKG_HAL_ARM_EBSA285 (Intel EBSA285 StrongARM board):
 aliases: hal_arm_ebsa285 arm_ebsa285_hal
 versions: v1_3_1
Package CYGPKG_HAL_ARM_EDB7XXX (Cirrus Logic development board):
 aliases: hal_arm_edb7xxx arm_edb7xxx_hal
 versions: v1_3_1
Package CYGPKG_HAL_ARM_PID (ARM development board (PID)):
 aliases: hal_arm_pid arm_pid_hal
 versions: v1_3_1
Package CYGPKG_HAL_I386 (i386 common HAL):
 aliases: hal_i386 i386_hal i386_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_I386_LINUX (Linux synthetic target):
 aliases: hal_i386_linux
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 versions: v1_3_1
Package CYGPKG_HAL_I386_PC (i386 PC target):
 aliases: hal_i386_pc
 versions: v1_3_1
Package CYGPKG_HAL_MIPS (MIPS common HAL):
 aliases: hal_mips mips_hal mips_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_MIPS_SIM (MIPS simulator):
 aliases: hal_mips_sim mips_sim_hal
 versions: v1_3_1
Package CYGPKG_HAL_MIPS_TX39 (TX39 chip HAL):
 aliases: hal_tx39 tx39_hal tx39_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_MIPS_TX39_JMR3904 (Toshiba JMR-TX3904 board):
 aliases: hal_tx39_jmr3904 tx39_jmr3904_hal
 versions: v1_3_1
Package CYGPKG_HAL_MIPS_VR4300 (VR4300 chip HAL):
 aliases: hal_vr4300 vr4300_hal vr4300_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_MIPS_VR4300_VRC4373 (NEC VRC4373 board):
 aliases: hal_vrc4373 vrc4373_hal
 versions: v1_3_1
Package CYGPKG_HAL_MN10300 (MN10300 common HAL):
 aliases: hal_mn10300 mn10300_hal mn10300_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_MN10300_AM31 (MN10300 AM31 variant HAL):
 aliases: hal_mn10300_am31 mn10300_am31_hal
 versions: v1_3_1
Package CYGPKG_HAL_MN10300_AM31_SIM (MN10300 simulator):
 aliases: hal_mn10300_sim mn10300_sim_hal
 versions: v1_3_1
Package CYGPKG_HAL_MN10300_AM31_STDEVAL1 (Matsushita stdeval1 board):
 aliases: hal_mn10300_stdeval1 mn10300_stdeval1_hal
 versions: v1_3_1
Package CYGPKG_HAL_MN10300_AM33 (MN10300 AM33 variant HAL):
 aliases: hal_mn10300_am33 mn10300_am33_hal
 versions: v1_3_1
Package CYGPKG_HAL_MN10300_AM33_STB (Matsushita STB board):
 aliases: hal_mn10300_am33_stb mn10300_am33_stb_hal
 versions: v1_3_1
Package CYGPKG_HAL_POWERPC (PowerPC common HAL):
 aliases: hal_powerpc powerpc_hal powerpc_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_POWERPC_COGENT (Cogent CMA286/287 board):
 aliases: hal_powerpc_cogent powerpc_cogent_hal
 versions: v1_3_1
Package CYGPKG_HAL_POWERPC_FADS (Motorola MPC8xxFADS board):
 aliases: hal_powerpc_fads powerpc_fads_hal
 versions: v1_3_1
Package CYGPKG_HAL_POWERPC_MBX (Motorola MBX860/821 board):
 aliases: hal_powerpc_mbx powerpc_mbx_hal
 versions: v1_3_1
Package CYGPKG_HAL_POWERPC_MPC8xx (PowerPC 8xx variant HAL):
 aliases: hal_mpc8xx mpc8xx_hal mpc8xx_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_POWERPC_PPC60x (PowerPC 60x variant HAL):
 aliases: hal_ppc60x ppc60x_hal ppc60x_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_POWERPC_SIM (PowerPC simulator):
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 aliases: hal_powerpc_sim powerpc_sim_hal
 versions: v1_3_1
Package CYGPKG_HAL_QUICC (Motorola MBX860/821 QUICC support):
 aliases: hal_quicc quicc_hal quicc
 versions: v1_3_1
Package CYGPKG_HAL_SH (SH common HAL):
 aliases: hal_sh sh_hal sh_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_SH_EDK7708 (Hitachi SH7708 board):
 aliases: hal_sh_edk sh_edk_hal
 versions: v1_3_1
Package CYGPKG_HAL_SPARCLITE (SPARClite common HAL):
 aliases: hal_sparclite sparclite_hal sparclite_arch_hal
 versions: v1_3_1
Package CYGPKG_HAL_SPARCLITE_SIM (SPARClite simulator):
 aliases: hal_sparclite_sim sparclite_sim_hal
 versions: v1_3_1
Package CYGPKG_HAL_SPARCLITE_SLEB (Fujitsu MB86800-MA01 board):
 aliases: hal_sparclite_sleb sparclite_sleb_hal
 versions: v1_3_1
Package CYGPKG_INFRA (Infrastructure):
 aliases: infra
 versions: v1_3_1
Package CYGPKG_IO (I/O sub-system):
 aliases: io
 versions: v1_3_1
Package CYGPKG_IO_PCI (PCI configuration library):
 aliases: io_pci
 versions: v1_3_1
Package CYGPKG_IO_SERIAL (Serial device drivers):
 aliases: serial io_serial
 versions: v1_3_1
Package CYGPKG_KERNEL (eCos kernel):
 aliases: kernel
 versions: v1_3_1
Package CYGPKG_LIBC (C library):
 aliases: libc clib clibrary
 versions: v1_3_1
Package CYGPKG_LIBM (Math library):
 aliases: libm mathlib mathlibrary
 versions: v1_3_1
Package CYGPKG_UITRON (uITRON compatibility):
 aliases: uitron
 versions: v1_3_1
Target aeb (ARM evaluation board (AEB-1)):
 aliases: aeb1
Target am31_sim (MN10300 AM31 minimal simulator):
 aliases:
Target cma230 (Cogent CMA230/222 board):
 aliases: cma222
Target cma28x (Cogent CMA286/287 board):
 aliases: cma286 cma287
Target ebsa285 (Intel EBSA285 StrongARM board):
 aliases: ebsa
Target edb7xxx (Cirrus Logic development board):
 aliases: edb7211 eb7xxx eb7211
Target fads (Motorola MPC8xxFADS board):
 aliases:
Target jmr3904 (Toshiba JMR-TX3904 board):
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 aliases: jmr tx39
Target linux (Linux synthetic target):
 aliases:
Target mbx (Motorola MBX860/821 board):
 aliases: mbx860 mbx821
Target pc (i386 PC target):
 aliases:
Target pid (ARM development board (PID)):
 aliases: PID
Target psim (PowerPC simulator):
 aliases: ppc_sim powerpc_sim
Target sh7708 (Hitachi SH7708 board):
 aliases: edk7708
Target sleb (Fujitsu MB86800-MA01 board):
 aliases:
Target sparclite_sim (SPARClite simulator):
 aliases: sl_sim sparcl_sim
Target stb (Matsushita STB board):
 aliases:
Target stdeval1 (Matsushita stdeval1 board):
 aliases:
Target tx39_sim (TX39 minimal simulator):
 aliases:
Target vrc4373 (NEC VRC4373 board):
 aliases:
Template all:
 versions: v1_3_1
Template cygmon:
 versions: v1_3_1
Template default:
 versions: v1_3_1
Template kernel:
 versions: v1_3_1
Template minimal:
 versions: v1_3_1
Template stubs:
 versions: v1_3_1
Template uitron:
 versions: v1_3_1

For detailed information about how to edit the ecos.ecc file, see the CDL Writer’s 
Guide.

Selecting a Target
To configure for a listed target, type: 
$ ecosconfig new <target>

For example, to configure for the ARM PID development board, type: 
$ ecosconfig new pid

Then edit the generated file, ecos.ecc, setting the options as required for the target 
(endianess, CPU model, Startup type, etc.)

Create a build tree for the configured target by typing:
$ ecosconfig tree
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You can now run the command make or make tests, after which you will be at the 
same point you would be after running the Configuration Tool on Windows— you 
can start developing your own applications, following the steps in “Building and 
Running Sample Applications” on page 79. 

The procedure shown above allows you to do very coarse-grained configuration of the 
eCos kernel: you can select which packages to include in your kernel, and give target 
and start-up options. But you cannot select components within a package, or set the 
very fine-grained options. 

To select fine-grained configuration options you will need to edit the configuration 
file ecos.ecc in the current directory and regenerate the build tree.

CAUTION

■ You should follow the manual configuration process described above very 
carefully, and you should read the comments in each file to see when one option 
depends on other options or packages being enabled or disabled. If you do not, 
you might end up with an inconsistently configured kernel which could fail to 
build or might execute incorrectly.

Architectural Notes
ARM and Thumb Interworking

While GNUPro tools allow ARM and Thumb code to be mixed on a  per-object basis, 
the eCos library (libtarget.a) must be compiled in whole for either ARM or Thumb. 
This is controlled by the "Enable Thumb instruction set" (CYGHWR_THUMB) 
switch. Note that not all  targets have support for Thumb mode execution.

Adding -mthumb-interwork to the architecture options will allow the  library to be 
linked with the application code of either ARM or Thumb type - or a mix. See the 
ARM GNUPro manuals for details about ARM and Thumb mode interworking.

CPU Family Model
Some targets can be equipped with either an ARM7 or an ARM9 daughter CPU 
module. The "ARM CPU family" (CYGHWR_HAL_ARM_CPU_FAMILY) option  
should be set accordingly.

Changing this option primarily affects compiler optimization in this release.

CPU Endian Mode
Some targets support either little or big endian operation. The "Use big-endian mode" 
(CYGHWR_HAL_ARM_BIGENDIAN) option should be set accordingly.
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Test Suites

The eCos kernel and other packages have test suites that rigorously exercise the 
available features and confirm correct execution. The  tests are run on many different 
possible configurations, but the high  number of configuration permutations makes it 
impossible to test them all. The use of test suites is particularly important for 
embedded systems, where software robustness is a priority. All eCos software  is 
tested prior to shipping, but if you define your own configuration, you will probably 
want to verify that the test cases work for it.

This release includes test suites for the eCos kernel, kernel C API, C library, µITRON 
compatibility, and device driver packages. The use of the test suites is similar for all 
packages. The tests are supplied as source code for building with your specific eCos  
configurations. The test case source code is located under the base source directory 
BASE_DIR/packages/:

■ compat/uitron/v1_3_1/tests    

■ hal/common/v1_3_1/tests    

■ io/serial/v1_3_1/tests    

■ devs/wallclock/v1_3_1/tests    

■ devs/watchdog/v1_3_1/tests    

■ kernel/v1_3_1/tests    

■ language/c/libc/v1_3_1/tests    

■ language/c/libm/v1_3_1/tests

 There may be additional tests found in other packages.

12
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Using the Configuration Tool
Each test suite consists of a number of test cases which can be executed individually. 
A test case may involve one or more individual  tests of the package’s features. 
Successful completion of each test within the test case is reported as a line of text that 
is sent to the diagnostic channel (usually the serial port) for display on a terminal or 
terminal emulator.

Each test case runs only once and usually requires target hardware to be reset on 
completion. Note that certain test cases may not terminate immediately, especially if 
they involve delays and run on a target simulator.

Using the Configuration Tool
Using the eCos Configuration Tool it is possible to automate the downloading and 
execution of tests with the appropriately configured eCos packages. To do so, compile 
and link the test cases by using the Build->Tests menu item, after which the tests can 
be downloaded and executed by selecting Tools->Run Tests.

When a test run is invoked, a resizable property sheet is displayed, comprising three 
tabs: Executables, Output and Summary.

Three buttons appear on the property sheet itself: Run/Stop, Close and Properties.

The Run button is used to initiate a test run. Those tests selected  on the Executables 
tab are run, and the output recorded on the Output and Summary tabs. During the 
course of a run, the Run button changes to Stop. This button may be used to interrupt 
a test run at any point.

See the eCos User’s Guide for further details.

Using the command line
At the moment, there is no tool for automating testing on Linux, so you will have to 
run the tests manually.

It may also be necessary to run tests by hand if the automated tool finds any failing 
tests: it may be necessary to diagnose the problem by debugging the test.

Build the tests by typing ‘make tests’ in the root of the build  directory. This will cause 
the tests to be built and installed under <install-path>/tests/.

Running the test manually is done simply by invoking GDB, connecting to the target, 
downloading the test, optionally setting some breakpoints, and then running the test. 
All this was covered in “Target Setup” on page 35.
eCos Getting Started with eCos ■ 77



Testing Filters
Testing Filters
While most test cases today run solely in the target environment, some packages may 
require external testing infrastructure and/or feedback from the external environment 
to do complete testing.

The serial package is an example of this. It is the first package to require external 
testing infrastructure, but it will certainly not be the last.

Since the serial line is also used for communication with GDB, a  filter is inserted in 
the communication pathway between GDB and the serial device which is connected to 
the hardware target. The filter forwards all communication between the two, but also 
listens for special commands embedded in the data stream from the target.

When such a command is seen, the filter stops forwarding data to GDB  from the 
target and enters a special mode. In this mode the test case running on the target is able 
to control the filter, commanding it to run various tests. While these tests run, GDB is 
isolated from the target.

As the test completes (or if the filter detects a target crash) the communication path 
between GDB and the hardware target is re-established, allowing GDB to resume 
control.

In theory, it is possible to extend the filter to provide a generic framework for other 
target-external testing components, thus decoupling the testing infrastructure from the 
(possibly limited) communication means provided by the target (serial, JTAG, 
Ethernet, etc). 

Another advantage is that the host tools will not need to know about the various 
testing environments required by the eCos packages, since all contact with the target 
will continue to happen via GDB.

It remains to be seen if it will be possible, or sensible, to implement all target-external 
testing infrastructure via filters.
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eCos Hello World
Building and Running Sample 
Applications

The example programs in this tutorial are included, along with a Makefile, in the 
examples directory of the eCos distribution. The first program you will run is a hello 
world-style application, then you will run a more complex application that 
demonstrates the creation of threads and the use of cyg_thread_delay(), and 
finally you will run one that uses clocks and alarm handlers.

The Makefile has two variables you will need to adjust: PKG_INSTALL_DIR and 
XCC.

Edit the Makefile, setting PKG_INSTALL_DIR to the install tree previously created by 
ecosconfig and uncommenting the relevant XCC line for your architecture.

eCos Hello World
The following code is found in the file hello.c in the examples directory: 

eCos hello world program listing
/* this is a simple hello world program */
#include <stdio.h>
int main(void)
{
 printf("Hello, eCos world!\n");
 return 0;
} 

13
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A Sample Program with Two Threads
To compile this or any other program that is not part of the eCos distribution, you can 
follow the procedures described below. Type this explicit compilation instruction 
(assuming your current working directory is also where you built the eCos kernel):
$ gcc -g -IBASE_DIR/ecos-work/install/include hello.c -LBASE_DIR/
ecos-work/install/lib -Ttarget.ld -nostdlib

The compilation instruction above contains some standard GCC options (for example, 
-g enables debugging), as well as some mention of paths (-IBASE_DIR/ecos-work/
install/include allows files like cyg/kernel/kapi.h to be found, and -
LBASE_DIR/ecos-work/install/lib allows the linker to find -Ttarget.ld). 

The executable program will be called a.out. 
NOTE Some target systems require special options to be passed to gcc to compile 

correctly for that system. Please examine the Makefile in the examples 
directory to see if this applies to your target.

You can now run the resulting program in the simulator using GDB the way you ran 
the test case. The procedure will be the same, but this time run "gdb" specifying "-nw 
a.out" on the command line:
$ gdb -nw a.out

For targets other than the synthetic linux target, you should now run the usual GDB 
commands described earlier. Once this is done, typing the command "run" at the (gdb) 
prompt ("continue" for real hardware) will allow the program to execute and print the 
string "Hello, eCos world!" on your screen.

On the synthetic linux target, you may use the "run" command immediately - you do 
not need to invoke simulator macros, nor the "load" command.

A Sample Program with Two 
Threads

Below is a program that uses some of eCos’ system calls. It creates two threads, each 
of which goes into an infinite loop in which it sleeps for a while (using 
cyg_thread_delay()). This code is found in the file twothreads.c in the 
examples directory.

eCos two-threaded program listing
#include <cyg/kernel/kapi.h>
#include <stdio.h>
#include <math.h>
#include <stdlib.h>

/* now declare (and allocate space for) some kernel objects,
 like the two threads we will use */
cyg_thread thread_s[2];/* space for two thread objects */
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A Sample Program with Two Threads
char stack[2][4096];/* space for two 4K stacks */

/* now the handles for the threads */
cyg_handle_t simple_threadA, simple_threadB;

/* and now variables for the procedure which is the thread */
cyg_thread_entry_t simple_program;

/* and now a mutex to protect calls to the C library */
cyg_mutex_t cliblock;

/* we install our own startup routine which sets up threads */
void cyg_user_start(void)
{
 printf("Entering twothreads’ cyg_user_start() function\n");

 cyg_mutex_init(&cliblock);

 cyg_thread_create(4, simple_program, (cyg_addrword_t) 0,
"Thread A", (void *) stack[0], 4096,
&simple_threadA, &thread_s[0]);

 cyg_thread_create(4, simple_program, (cyg_addrword_t) 1,
"Thread B", (void *) stack[1], 4096,
&simple_threadB, &thread_s[1]);

 cyg_thread_resume(simple_threadA);
 cyg_thread_resume(simple_threadB);
}

/* this is a simple program which runs in a thread */
void simple_program(cyg_addrword_t data)
{
 int message = (int) data;
 int delay;

 printf("Beginning execution; thread data is %d\n", message);

 cyg_thread_delay(200);

 for (;;) {
 delay = 200 + (rand() % 50);

 /* note: printf() must be protected by a
 call to cyg_mutex_lock() */
 cyg_mutex_lock(&cliblock); {
 printf("Thread %d: and now a delay of %d clock ticks\n",
message, delay);

 }
 cyg_mutex_unlock(&cliblock);
 cyg_thread_delay(delay);
 }
} 

When you run the program (by typing run at the (gdb) prompt) the output should look 
like this:
Starting program: BASE_DIR/examples/twothreads.exe
Entering twothreads’ cyg_user_start() function
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Beginning execution; thread data is 0
Beginning execution; thread data is 1
Thread 0: and now a delay of 240 clock ticks
Thread 1: and now a delay of 225 clock ticks
Thread 1: and now a delay of 234 clock ticks
Thread 0: and now a delay of 231 clock ticks
Thread 1: and now a delay of 224 clock ticks
Thread 0: and now a delay of 249 clock ticks
Thread 1: and now a delay of 202 clock ticks
Thread 0: and now a delay of 235 clock ticks 

NOTE When running in a simulator the delays might be quite long. On a hardware 
board (where the clock speed is 100 ticks/second) the delays should average 
to about 2.25 seconds. In simulation, the delay will depend on the speed of the 
processor and will almost always be much slower than the actual board. You 
might want to reduce the delay parameter when running in simulation. 

Figure 9, page 83 shows how this multitasking program executes. Note that apart from 
the thread creation system calls, this program also creates and uses a mutex for 
synchronization between the printf() calls in the two threads. This is because the 
C library standard I/O (by default) is configured not to be thread-safe, which means 
that if more than one thread is using standard I/O they might corrupt each other. This 
is fixed by a mutual exclusion (or mutex) lockout mechanism: the threads do not call 
printf() until cyg_mutex_lock() has returned, which only happens when the 
other thread calls cyg_mutex_unlock().

You could avoid using the mutex by configuring the C library to be thread-safe (by 
selecting the component CYGSEM_LIBC_STDIO_THREAD_SAFE_STREAMS). Keep in mind 
that if the C library is thread-safe, you can no longer use printf() in 
cyg_user_start(). 
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A Sample Program with Two Threads
Figure 9: Two threads with simple print statements after random delays
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A Sample Program with Alarms
More Features — Clocks and 
Alarm Handlers

If a program wanted to execute a task at a given time, or periodically, it could do it in 
an inefficient way by sitting in an infinite loop and checking the real-time clock to see 
if the proper amount of time has elapsed. But operating systems usually provide 
system calls which allow the program to be interrupted at the desired time.

eCos provides a rich timekeeping formalism, involving counters, clocks, alarms, and 
timers. The precise definition, relationship, and motivation of these features is beyond 
the scope of this tutorial, but these examples illustrate how to set up basic periodic 
tasks.

Alarms are events that happen at a given time, either once or periodically. A thread 
associates an alarm handling function with the alarm, so that the function will be 
invoked every time the alarm “goes off”.

A Sample Program with Alarms
simple-alarm.c (in the examples directory) is a short program that creates a thread 
that creates an alarm. The alarm is handled by the function test_alarm_func(), 
which sets a global variable. When the main thread of execution sees that the variable 
has changed, it prints a message.

14
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A Sample Program with Alarms
Table 4: A sample program that creates an alarm
 /* this is a very simple program meant to demonstrate
 a basic use of time, alarms and alarm-handling functions
 in eCos */

#include <cyg/kernel/kapi.h>

#include <stdio.h>

#define NTHREADS 1
#define STACKSIZE 4096

static cyg_handle_t thread[NTHREADS];

static cyg_thread thread_obj[NTHREADS];
static char stack[NTHREADS][STACKSIZE];

static void alarm_prog( cyg_addrword_t data );

/* we install our own startup routine which sets up
 threads and starts the scheduler */
void cyg_user_start(void)
{
 cyg_thread_create(4, alarm_prog, (cyg_addrword_t) 0,
"alarm_thread", (void *) stack[0],
STACKSIZE, &thread[0], &thread_obj[0]);

 cyg_thread_resume(thread[0]);
}

/* we need to declare the alarm handling function (which is
 defined below), so that we can pass it to
 cyg_alarm_initialize() */
cyg_alarm_t test_alarm_func;

/* alarm_prog() is a thread which sets up an alarm which is then
 handled by test_alarm_func() */
static void alarm_prog(cyg_addrword_t data)
{
 cyg_handle_t test_counterH, system_clockH, test_alarmH;
 cyg_tick_count_t ticks;
 cyg_alarm test_alarm;
 unsigned how_many_alarms = 0, prev_alarms = 0, tmp_how_many;

 system_clockH = cyg_real_time_clock();
 cyg_clock_to_counter(system_clockH, &test_counterH);
 cyg_alarm_create(test_counterH, test_alarm_func,
(cyg_addrword_t) &how_many_alarms,
&test_alarmH, &test_alarm);

 cyg_alarm_initialize(test_alarmH, cyg_current_time()+200, 200);

 /* get in a loop in which we read the current time and
 print it out, just to have something scrolling by */
 for (;;) {
 ticks = cyg_current_time();
 printf("Time is %llu\n", ticks);
 /* note that we must lock access to how_many_alarms, since the
 alarm handler might change it. this involves using the
 annoying temporary variable tmp_how_many so that I can keep the
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 critical region short */
 cyg_scheduler_lock();
 tmp_how_many = how_many_alarms;
 cyg_scheduler_unlock();
 if (prev_alarms != tmp_how_many) {
 printf(" --- alarm calls so far: %u\n", tmp_how_many);
 prev_alarms = tmp_how_many;
 }
 cyg_thread_delay(30);
 }
}

/* test_alarm_func() is invoked as an alarm handler, so
 it should be quick and simple. in this case it increments
 the data that is passed to it. */
void test_alarm_func(cyg_handle_t alarmH, cyg_addrword_t data)
{
 ++*((unsigned *) data);
} 

When you run this program (by typing run at the (gdb) prompt) the output should 
look like this:

Starting program: BASE_DIR/examples/simple-alarm.exe
Time is 0
Time is 30
Time is 60
Time is 90
Time is 120
Time is 150
Time is 180
Time is 210
  --- alarm calls so far: 1
Time is 240
Time is 270
Time is 300
Time is 330
Time is 360
Time is 390
Time is 420
  --- alarm calls so far: 2
Time is 450
Time is 480 

NOTE When running in a simulator the delays might be quite long. On a hardware 
board (where the clock speed is 100 ticks/second) the delays should average 
to about 0.3 seconds (and 2 seconds between alarms). In simulation, the delay 
will depend on the speed of the processor and will almost always be much 
slower than the actual board. You might want to reduce the delay parameter 
when running in simulation. 

Here are a few things you might notice about this program:

■ It used the cyg_real_time_clock(); this always returns a handle to the 
default system real-time clock. 
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■ Alarms are based on counters, so the function cyg_alarm_create() uses a 
counter handle. The program used the function cyg_clock_to_counter() 
to strip the clock handle to the underlying counter handle. 

■ Once the alarm is created it is initialized with cyg_alarm_initialize(), 
which sets the time at which the alarm should go off, as well as the period for 
repeating alarms. It is set to go off at the current time and then to repeat every 200 
ticks. 

■ The alarm handler function test_alarm_func() conforms to the guidelines 
for writing alarm handlers and other delayed service routines: it does not invoke 
any functions which might lock the scheduler. This is discussed in detail in the 
eCos Reference Manual, in the chapter Requirements for programs.

■ There is a critical region in this program: the variable how_many_alarms is 
accessed in the main thread of control and is also modified in the alarm handler. 
To prevent a possible (though unlikely) race condition on this variable, access to 
how_many_alarms in the principal thread is protected by calls to 
cyg_scheduler_lock() and cyg_scheduler_unlock(). When the 
scheduler is locked, the alarm handler will not be invoked, so the problem is 
averted. 
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Sample numbers:
Appendix 1: Real-time 
characterization

For a discussion of real-time performance measurement for eCos, see the eCos Users’ 
Guide.

Sample numbers:
Board: ARM AEB-1 Revision B Evaluation Board

CPU : Sharp LH77790A 24MHz

Startup, main stack             : stack used   404 size  2400
Startup              :  Interrupt stack used   128 size  2048
Startup              : Idlethread stack used    80 size  2048

eCos Kernel Timings
Notes: all times are in microseconds (.000001) unless otherwise stated

Reading the hardware clock takes 13 ’ticks’ overhead
... this value will be factored out of all other measurements
Clock interrupt took  193.49 microseconds (290 raw clock ticks)

Testing parameters:
   Clock samples:            32
   Threads:                   7
   Thread switches:         128
   Mutexes:                  32
   Mailboxes:                32
   Semaphores:               32
   Scheduler operations:    128
   Counters:                 32
   Alarms:                   32

                                 Confidence
     Ave     Min     Max     Var  Ave  Min  Function
  ======  ======  ======  ====== ========== ========
  110.19  104.67  116.00    3.26   42%  28% Create thread
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   34.00   34.00   34.00    0.00  100% 100% Yield thread [all suspended]
   24.67   24.67   24.67    0.00  100% 100% Suspend [suspended] thread
   25.05   24.67   25.33    0.33   57%  42% Resume thread
   37.14   36.67   37.33    0.27   71%  28% Set priority
    3.81    3.33    4.00    0.27   71%  28% Get priority
   80.00   80.00   80.00    0.00  100% 100% Kill [suspended] thread
   33.90   33.33   34.00    0.16   85%  14% Yield [no other] thread
   45.90   44.00   46.67    0.54   57%  14% Resume [suspended low prio] thread
   24.57   24.00   24.67    0.16   85%  14% Resume [runnable low prio] thread
   42.29   36.67   43.33    1.61   85%  14% Suspend [runnable] thread
   33.90   33.33   34.00    0.16   85%  14% Yield [only low prio] thread
   24.67   24.67   24.67    0.00  100% 100% Suspend [runnable->not runnable]
   80.00   80.00   80.00    0.00  100% 100% Kill [runnable] thread
   43.33   43.33   43.33    0.00  100% 100% Destroy [dead] thread
  106.29  101.33  107.33    1.41   85%  14% Destroy [runnable] thread
  144.95  141.33  166.00    6.01   85%  85% Resume [high priority] thread
   78.31   76.67  254.67    2.75   99%  99% Thread switch

    4.00    4.00    4.00    0.00  100% 100% Scheduler lock
   16.37   16.00   16.67    0.33   56%  43% Scheduler unlock [0 threads]
   16.37   16.00   16.67    0.33   56%  43% Scheduler unlock [1 suspended]
   16.37   16.00   16.67    0.33   56%  43% Scheduler unlock [many suspended]
   16.37   16.00   16.67    0.33   56%  43% Scheduler unlock [many low prio]

   10.67   10.67   10.67    0.00  100% 100% Init mutex
   28.67   28.67   28.67    0.00  100% 100% Lock [unlocked] mutex
   30.44   30.00   31.33    0.33   59%  37% Unlock [locked] mutex
   25.42   25.33   26.00    0.15   87%  87% Trylock [unlocked] mutex
   22.50   22.00   22.67    0.25   75%  25% Trylock [locked] mutex
    5.75    5.33    6.00    0.31   62%  37% Destroy mutex
  185.33  185.33  185.33    0.00  100% 100% Unlock/Lock mutex

   20.17   20.00   20.67    0.25   75%  75% Create mbox
    2.92    2.67    3.33    0.31   62%  62% Peek [empty] mbox
   32.42   32.00   32.67    0.31   62%  37% Put [first] mbox
    3.00    2.67    3.33    0.33  100%  50% Peek [1 msg] mbox
   32.50   32.00   32.67    0.25   75%  25% Put [second] mbox
    2.92    2.67    3.33    0.31   62%  62% Peek [2 msgs] mbox
   32.83   32.67   33.33    0.25   75%  75% Get [first] mbox
   32.67   32.67   32.67    0.00  100% 100% Get [second] mbox
   31.33   31.33   31.33    0.00  100% 100% Tryput [first] mbox
   27.58   27.33   28.00    0.31   62%  62% Peek item [non-empty] mbox
   32.83   32.67   33.33    0.25   75%  75% Tryget [non-empty] mbox
   26.50   26.00   26.67    0.25   75%  25% Peek item [empty] mbox
   28.00   28.00   28.00    0.00  100% 100% Tryget [empty] mbox
    3.25    2.67    3.33    0.15   87%  12% Waiting to get mbox
    3.25    2.67    3.33    0.15   87%  12% Waiting to put mbox
   30.83   30.67   31.33    0.25   75%  75% Delete mbox
  101.08  100.67  101.33    0.31   62%  37% Put/Get mbox

   11.17   10.67   11.33    0.25   75%  25% Init semaphore
   24.17   24.00   24.67    0.25   75%  75% Post [0] semaphore
   27.08   26.67   27.33    0.31   62%  37% Wait [1] semaphore
   22.75   22.67   23.33    0.15   87%  87% Trywait [0] semaphore
   22.21   22.00   22.67    0.29   68%  68% Trywait [1] semaphore
    7.33    7.33    7.33    0.00  100% 100% Peek semaphore
    5.92    5.33    6.00    0.15   87%  12% Destroy semaphore
  110.04  110.00  110.67    0.08   93%  93% Post/Wait semaphore
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    9.54    9.33   10.00    0.29   68%  68% Create counter
    3.92    3.33    4.00    0.15   87%  12% Get counter value
    4.00    4.00    4.00    0.00  100% 100% Set counter value
   30.92   30.67   31.33    0.31   62%  62% Tick counter
    5.75    5.33    6.00    0.31   62%  37% Delete counter

   13.83   13.33   14.00    0.25   75%  25% Create alarm
   46.67   46.67   46.67    0.00  100% 100% Initialize alarm
    3.67    3.33    4.00    0.33  100%  50% Disable alarm
   45.67   45.33   46.00    0.33  100%  50% Enable alarm
    8.33    8.00    8.67    0.33  100%  50% Delete alarm
   36.33   36.00   36.67    0.33  100%  50% Tick counter [1 alarm]
  214.67  214.67  214.67    0.00  100% 100% Tick counter [many alarms]
   62.67   62.67   62.67    0.00  100% 100% Tick & fire counter [1 alarm]
 1087.04 1075.33 1278.67   21.91   93%  93% Tick & fire counters [>1 together]
  246.35  240.67  412.00   10.35   96%  96% Tick & fire counters [>1 separately]
  168.01  167.33  237.33    1.08   99%  99% Alarm latency [0 threads]
  187.36  168.00  234.67    3.60   86%   1% Alarm latency [2 threads]
  187.37  167.33  235.33    3.59   85%   1% Alarm latency [many threads]
  303.12  280.00  508.67    3.21   98%   0% Alarm -> thread resume latency

   36.65   36.00   38.67    0.00            Clock/interrupt latency

   65.79   52.00  152.67    0.00            Clock DSR latency

  316     316     316  (main stack:   752)  Thread stack used (1120 total)
All done, main stack            : stack used   752 size  2400
All done             :  Interrupt stack used   280 size  2048
All done             : Idlethread stack used   268 size  2048

Timing complete - 30390 ms total

PASS:<Basic timing OK>
EXIT:<done>

Board: Intel StrongARM EBSA-285 Evaluation Board

CPU   : Intel StrongARM SA-110 228MHz

Startup, main stack             : stack used   404 size  2400
Startup              :  Interrupt stack used   136 size  4096
Startup              : Idlethread stack used    80 size  2048

eCos Kernel Timings
Notes: all times are in microseconds (.000001) unless otherwise stated

Reading the hardware clock takes 1 ’ticks’ overhead
... this value will be factored out of all other measurements
Clock interrupt took    4.61 microseconds (16 raw clock ticks)

Testing parameters:
   Clock samples:            32
   Threads:                  64
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   Thread switches:         128
   Mutexes:                  32
   Mailboxes:                32
   Semaphores:               32
   Scheduler operations:    128
   Counters:                 32
   Alarms:                   32

                                 Confidence
     Ave     Min     Max     Var  Ave  Min  Function
  ======  ======  ======  ====== ========== ========
    4.97    3.26    7.34    0.60   50%   4% Create thread
    0.73    0.54    2.17    0.14   60%  37% Yield thread [all suspended]
    0.98    0.82    2.99    0.23   81%  68% Suspend [suspended] thread
    0.54    0.27    1.63    0.03   92%   6% Resume thread
    0.83    0.54    1.90    0.10   73%  14% Set priority
    0.21    0.00    0.54    0.21   25%  48% Get priority
    2.25    1.90   10.05    0.37   96%  67% Kill [suspended] thread
    0.70    0.54    1.09    0.14   53%  45% Yield [no other] thread
    0.96    0.82    1.36    0.14   50%  48% Resume [suspended low prio] thread
    0.53    0.27    0.82    0.03   92%   6% Resume [runnable low prio] thread
    0.90    0.82    1.63    0.13   70%  70% Suspend [runnable] thread
    0.70    0.54    0.82    0.13   57%  42% Yield [only low prio] thread
    0.55    0.54    0.82    0.01   98%  98% Suspend [runnable->not runnable]
    1.64    1.63    2.17    0.02   98%  98% Kill [runnable] thread
    0.97    0.82    4.62    0.20   98%  64% Destroy [dead] thread
    2.17    1.90    2.17    0.01   98%   1% Destroy [runnable] thread
    6.06    5.16   10.60    0.53   59%  31% Resume [high priority] thread
    1.69    1.63    5.98    0.11   90%  90% Thread switch

    0.14    0.00    1.36    0.14   99%  50% Scheduler lock
    0.37    0.27    0.54    0.13   62%  62% Scheduler unlock [0 threads]
    0.38    0.27    0.54    0.13   60%  60% Scheduler unlock [1 suspended]
    0.37    0.27    0.54    0.13   63%  63% Scheduler unlock [many suspended]
    0.37    0.27    0.54    0.13   63%  63% Scheduler unlock [many low prio]

    0.34    0.00    1.90    0.15   78%   6% Init mutex
    0.88    0.54    4.62    0.37   93%  71% Lock [unlocked] mutex
    0.79    0.54    4.35    0.26   93%  53% Unlock [locked] mutex
    0.59    0.27    2.17    0.10   93%   3% Trylock [unlocked] mutex
    0.50    0.27    0.82    0.09   78%  18% Trylock [locked] mutex
    0.18    0.00    0.54    0.13   59%  37% Destroy mutex
    3.85    3.80    5.16    0.08   96%  96% Unlock/Lock mutex

    0.64    0.27    3.53    0.24   81%  15% Create mbox
    0.61    0.27    2.17    0.21   68%  18% Peek [empty] mbox
    0.87    0.54    5.16    0.31   59%  87% Put [first] mbox
    0.08    0.00    0.54    0.12   71%  71% Peek [1 msg] mbox
    0.71    0.54    1.09    0.14   56%  40% Put [second] mbox
    0.08    0.00    0.27    0.12   68%  68% Peek [2 msgs] mbox
    0.89    0.54    4.89    0.31   62%  81% Get [first] mbox
    0.76    0.54    1.09    0.17   43%  37% Get [second] mbox
    0.76    0.54    3.26    0.21   96%  50% Tryput [first] mbox
    0.65    0.54    2.45    0.17   81%  81% Peek item [non-empty] mbox
    0.76    0.54    2.72    0.19   53%  43% Tryget [non-empty] mbox
    0.58    0.54    0.82    0.06   87%  87% Peek item [empty] mbox
    0.61    0.54    0.82    0.10   75%  75% Tryget [empty] mbox
    0.10    0.00    0.54    0.13   65%  65% Waiting to get mbox
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    0.10    0.00    0.54    0.13   65%  65% Waiting to put mbox
    0.77    0.54    3.26    0.20   53%  43% Delete mbox
    2.10    1.90    6.25    0.30   93%  93% Put/Get mbox

    0.34    0.27    1.09    0.11   81%  81% Init semaphore
    0.60    0.27    1.09    0.12   68%   6% Post [0] semaphore
    0.59    0.54    0.82    0.08   81%  81% Wait [1] semaphore
    0.59    0.54    2.17    0.10   96%  96% Trywait [0] semaphore
    0.48    0.27    0.82    0.11   71%  25% Trywait [1] semaphore
    0.24    0.00    0.82    0.09   78%  18% Peek semaphore
    0.19    0.00    0.54    0.13   62%  34% Destroy semaphore
    2.28    2.17    4.08    0.18   93%  90% Post/Wait semaphore

    0.43    0.00    2.72    0.23   90%   6% Create counter
    0.40    0.00    1.63    0.25   68%  28% Get counter value
    0.13    0.00    0.82    0.15   96%  59% Set counter value
    0.71    0.54    1.63    0.16   50%  46% Tick counter
    0.16    0.00    0.54    0.14   53%  43% Delete counter

    0.47    0.27    1.36    0.15   59%  37% Create alarm
    1.58    1.09    7.07    0.44   71%  68% Initialize alarm
    0.12    0.00    1.09    0.16   96%  65% Disable alarm
    1.01    0.82    2.45    0.17   53%  43% Enable alarm
    0.21    0.00    0.27    0.09   78%  21% Delete alarm
    0.78    0.54    1.90    0.12   71%  25% Tick counter [1 alarm]
    3.90    3.80    4.35    0.13   68%  68% Tick counter [many alarms]
    1.25    1.09    1.63    0.14   53%  43% Tick & fire counter [1 alarm]
   19.88   19.84   20.11    0.07   84%  84% Tick & fire counters [>1 together]
    4.37    4.35    4.62    0.05   90%  90% Tick & fire counters [>1 separately]
    3.83    3.80    7.61    0.06   99%  99% Alarm latency [0 threads]
    4.46    3.80    7.88    0.27   71%  24% Alarm latency [2 threads]
   16.06   13.59   26.36    1.05   54%  10% Alarm latency [many threads]
    6.67    6.52   22.83    0.29   98%  98% Alarm -> thread resume latency

    1.89    0.82    9.78    0.00            Clock/interrupt latency

    2.17    1.09    7.34    0.00            Clock DSR latency

   11       0     316  (main stack:   744)  Thread stack used (1120 total)
All done, main stack            : stack used   744 size  2400
All done             :  Interrupt stack used   288 size  4096
All done             : Idlethread stack used   268 size  2048

Timing complete - 30210 ms total

PASS:<Basic timing OK>
EXIT:<done>

Board: Cirrus Logic EDB7111-2 Development Board

CPU  : Cirrus Logic EP7211 73MHz

Startup, main stack             : stack used   404 size  2400
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Startup              :  Interrupt stack used   136 size  4096
Startup              : Idlethread stack used    88 size  2048

eCos Kernel Timings
Notes: all times are in microseconds (.000001) unless otherwise stated

Reading the hardware clock takes 0 ’ticks’ overhead
... this value will be factored out of all other measurements
Clock interrupt took  356.69 microseconds (182 raw clock ticks)

Testing parameters:
   Clock samples:            32
   Threads:                  64
   Thread switches:         128
   Mutexes:                  32
   Mailboxes:                32
   Semaphores:               32
   Scheduler operations:    128
   Counters:                 32
   Alarms:                   32

                                 Confidence
     Ave     Min     Max     Var  Ave  Min  Function
  ======  ======  ======  ====== ========== ========
   22.71   17.58   37.11    3.07   46%  34% Create thread
    4.36    3.91    5.86    0.70   76%  76% Yield thread [all suspended]
    4.24    3.91    7.81    0.56   84%  84% Suspend [suspended] thread
    4.09    1.95    7.81    0.45   85%   3% Resume thread
    5.31    3.91   11.72    0.92   65%  32% Set priority
    2.11    1.95    3.91    0.28   92%  92% Get priority
   11.54    9.77   25.39    0.99   62%  28% Kill [suspended] thread
    4.46    3.91    9.77    0.82   75%  75% Yield [no other] thread
    7.57    5.86   13.67    0.69   75%  20% Resume [suspended low prio] thread
    3.94    1.95    5.86    0.18   92%   3% Resume [runnable low prio] thread
    7.02    5.86   13.67    1.05   53%  45% Suspend [runnable] thread
    4.42    3.91    9.77    0.79   76%  76% Yield [only low prio] thread
    4.24    1.95    5.86    0.61   79%   1% Suspend [runnable->not runnable]
   11.29    9.77   27.34    1.14   57%  37% Kill [runnable] thread
    6.29    3.91   11.72    0.84   71%   4% Destroy [dead] thread
   13.52   11.72   31.25    0.90   70%  25% Destroy [runnable] thread
   24.50   21.48   42.97    1.69   79%  12% Resume [high priority] thread
    8.79    7.81   19.53    1.05   99%  53% Thread switch

    1.66    0.00    3.91    0.52   83%  15% Scheduler lock
    2.59    1.95    3.91    0.86   67%  67% Scheduler unlock [0 threads]
    2.62    1.95    3.91    0.88   65%  65% Scheduler unlock [1 suspended]
    2.61    1.95    3.91    0.87   66%  66% Scheduler unlock [many suspended]
    2.58    1.95    3.91    0.85   67%  67% Scheduler unlock [many low prio]

    2.69    1.95    5.86    0.96   65%  65% Init mutex
    4.88    3.91    9.77    1.10   96%  56% Lock [unlocked] mutex
    4.64    3.91   11.72    1.05   71%  71% Unlock [locked] mutex
    3.97    1.95    7.81    0.47   81%   9% Trylock [unlocked] mutex
    3.48    1.95    3.91    0.67   78%  21% Trylock [locked] mutex
    1.77    0.00    3.91    0.44   84%  12% Destroy mutex
   31.92   29.30   42.97    1.65   71%  18% Unlock/Lock mutex

    4.09    3.91    9.77    0.35   96%  96% Create mbox
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    1.83    0.00    3.91    0.34   87%   9% Peek [empty] mbox
    5.31    3.91    9.77    0.96   62%  34% Put [first] mbox
    1.59    0.00    1.95    0.60   81%  18% Peek [1 msg] mbox
    5.19    3.91    9.77    1.04   56%  40% Put [second] mbox
    1.65    0.00    3.91    0.62   78%  18% Peek [2 msgs] mbox
    5.43    3.91    9.77    0.86   68%  28% Get [first] mbox
    5.31    3.91    7.81    0.96   59%  34% Get [second] mbox
    4.76    3.91    9.77    1.07   62%  62% Tryput [first] mbox
    4.82    1.95    9.77    1.15   93%   3% Peek item [non-empty] mbox
    5.55    3.91   11.72    0.82   71%  25% Tryget [non-empty] mbox
    3.97    1.95    7.81    0.59   75%  12% Peek item [empty] mbox
    4.33    3.91    7.81    0.69   81%  81% Tryget [empty] mbox
    1.59    0.00    3.91    0.79   68%  25% Waiting to get mbox
    1.71    0.00    3.91    0.53   81%  15% Waiting to put mbox
    5.25    3.91    9.77    1.01   59%  37% Delete mbox
   17.82   15.63   29.30    1.14   65%  18% Put/Get mbox

    2.69    1.95    5.86    0.96   65%  65% Init semaphore
    3.78    1.95    7.81    0.46   84%  12% Post [0] semaphore
    4.27    3.91    7.81    0.62   84%  84% Wait [1] semaphore
    3.72    1.95    7.81    0.66   75%  18% Trywait [0] semaphore
    3.29    1.95    5.86    0.92   62%  34% Trywait [1] semaphore
    2.32    1.95    3.91    0.59   81%  81% Peek semaphore
    1.89    0.00    3.91    0.24   90%   6% Destroy semaphore
   15.75   13.67   29.30    1.07   68%  21% Post/Wait semaphore

    2.69    1.95    5.86    0.96   65%  65% Create counter
    1.83    0.00    1.95    0.23   93%   6% Get counter value
    1.53    0.00    3.91    0.76   71%  25% Set counter value
    4.82    3.91    5.86    0.97   53%  53% Tick counter
    1.89    0.00    1.95    0.12   96%   3% Delete counter

    3.78    1.95    7.81    0.46   84%  12% Create alarm
    7.99    5.86   15.63    0.70   81%   9% Initialize alarm
    1.71    0.00    1.95    0.43   87%  12% Disable alarm
    7.14    5.86   11.72    1.04   56%  40% Enable alarm
    2.50    1.95    3.91    0.79   71%  71% Delete alarm
    4.94    3.91    7.81    1.04   96%  50% Tick counter [1 alarm]
   19.47   17.58   23.44    0.36   87%   9% Tick counter [many alarms]
    7.63    5.86   11.72    0.55   81%  15% Tick & fire counter [1 alarm]
   99.06   97.66  105.47    1.05   59%  37% Tick & fire counters [>1 together]
   22.15   21.48   27.34    0.96   71%  71% Tick & fire counters [>1 separately]
  359.16  357.42  378.91    0.87   71%  25% Alarm latency [0 threads]
  364.03  357.42  402.34    3.03   58%  15% Alarm latency [2 threads]
  408.25  402.34  416.02    2.89   53%  24% Alarm latency [many threads]
  381.16  376.95  492.19    2.48   95%  46% Alarm -> thread resume latency

    9.79    5.86   19.53    0.00            Clock/interrupt latency

   12.13    5.86   31.25    0.00            Clock DSR latency

   12       0     316  (main stack:   752)  Thread stack used (1120 total)
All done, main stack            : stack used   752 size  2400
All done             :  Interrupt stack used   288 size  4096
All done             : Idlethread stack used   276 size  2048

Timing complete - 30450 ms total

PASS:<Basic timing OK>
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EXIT:<done>

Board: Cirrus Logic EDB7111-2 Development Board

CPU  : Cirrus Logic EP7212 73MHz

Startup, main stack             : stack used   404 size  2400
Startup              :  Interrupt stack used   136 size  4096
Startup              : Idlethread stack used    88 size  2048

eCos Kernel Timings
Notes: all times are in microseconds (.000001) unless otherwise stated

Reading the hardware clock takes 0 ’ticks’ overhead
... this value will be factored out of all other measurements
Clock interrupt took  356.32 microseconds (182 raw clock ticks)

Testing parameters:
   Clock samples:            32
   Threads:                  64
   Thread switches:         128
   Mutexes:                  32
   Mailboxes:                32
   Semaphores:               32
   Scheduler operations:    128
   Counters:                 32
   Alarms:                   32

                                 Confidence
     Ave     Min     Max     Var  Ave  Min  Function
  ======  ======  ======  ====== ========== ========
   22.43   15.63   33.20    3.02   68%  18% Create thread
    4.48    3.91    5.86    0.81   70%  70% Yield thread [all suspended]
    4.42    3.91    7.81    0.78   75%  75% Suspend [suspended] thread
    4.12    1.95    5.86    0.49   82%   3% Resume thread
    5.62    3.91   11.72    0.64   78%  18% Set priority
    2.17    1.95    3.91    0.38   89%  89% Get priority
   11.54    9.77   27.34    0.88   70%  25% Kill [suspended] thread
    4.64    3.91    9.77    0.96   65%  65% Yield [no other] thread
    7.51    5.86   15.63    0.72   76%  21% Resume [suspended low prio] thread
    3.88    1.95    9.77    0.42   82%  10% Resume [runnable low prio] thread
    7.14    5.86   13.67    1.00   59%  39% Suspend [runnable] thread
    4.52    3.91    7.81    0.86   70%  70% Yield [only low prio] thread
    4.15    1.95    7.81    0.49   85%   1% Suspend [runnable->not runnable]
   11.26    9.77   27.34    1.17   56%  39% Kill [runnable] thread
    6.22    3.91   13.67    0.88   70%   7% Destroy [dead] thread
   13.64   11.72   33.20    1.02   64%  26% Destroy [runnable] thread
   24.17   21.48   41.02    1.49   82%  12% Resume [high priority] thread
    8.80    7.81   21.48    1.08   98%  54% Thread switch

    1.60    0.00    1.95    0.58   82%  17% Scheduler lock
    2.61    1.95    3.91    0.87   66%  66% Scheduler unlock [0 threads]
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    2.59    1.95    3.91    0.86   67%  67% Scheduler unlock [1 suspended]
    2.61    1.95    3.91    0.87   66%  66% Scheduler unlock [many suspended]
    2.59    1.95    3.91    0.86   67%  67% Scheduler unlock [many low prio]

    2.62    1.95    3.91    0.88   65%  65% Init mutex
    4.82    3.91    9.77    1.09   96%  59% Lock [unlocked] mutex
    4.39    3.91    9.77    0.79   81%  81% Unlock [locked] mutex
    3.84    1.95    7.81    0.36   87%   9% Trylock [unlocked] mutex
    3.54    1.95    5.86    0.69   75%  21% Trylock [locked] mutex
    1.83    0.00    3.91    0.34   87%   9% Destroy mutex
   34.61   31.25   46.88    1.68   78%   9% Unlock/Lock mutex

    3.97    1.95    7.81    0.24   93%   3% Create mbox
    1.83    0.00    3.91    0.34   87%   9% Peek [empty] mbox
    4.76    3.91    9.77    1.07   62%  62% Put [first] mbox
    1.71    0.00    3.91    0.64   75%  18% Peek [1 msg] mbox
    5.00    3.91    9.77    1.10   96%  50% Put [second] mbox
    1.65    0.00    1.95    0.52   84%  15% Peek [2 msgs] mbox
    5.31    3.91   11.72    1.05   59%  37% Get [first] mbox
    5.13    3.91    7.81    0.99   56%  40% Get [second] mbox
    4.76    3.91   11.72    1.12   96%  65% Tryput [first] mbox
    4.46    3.91    7.81    0.82   75%  75% Peek item [non-empty] mbox
    5.55    3.91    9.77    0.82   68%  25% Tryget [non-empty] mbox
    4.03    1.95    7.81    0.58   78%   9% Peek item [empty] mbox
    4.27    3.91    5.86    0.59   81%  81% Tryget [empty] mbox
    1.77    0.00    3.91    0.44   84%  12% Waiting to get mbox
    1.59    0.00    1.95    0.60   81%  18% Waiting to put mbox
    5.37    3.91    9.77    0.91   65%  31% Delete mbox
   16.66   13.67   27.34    1.42   90%   3% Put/Get mbox

    2.62    1.95    5.86    0.92   68%  68% Init semaphore
    3.84    1.95    7.81    0.47   81%  12% Post [0] semaphore
    4.21    3.91    7.81    0.53   87%  87% Wait [1] semaphore
    3.48    1.95    5.86    0.76   71%  25% Trywait [0] semaphore
    3.60    1.95    5.86    0.62   78%  18% Trywait [1] semaphore
    2.26    1.95    5.86    0.53   87%  87% Peek semaphore
    1.89    0.00    1.95    0.12   96%   3% Destroy semaphore
   16.05   13.67   29.30    1.40   59%  18% Post/Wait semaphore

    2.38    1.95    3.91    0.67   78%  78% Create counter
    2.01    0.00    3.91    0.35   84%   6% Get counter value
    1.89    0.00    3.91    0.24   90%   6% Set counter value
    4.58    3.91    5.86    0.88   65%  65% Tick counter
    1.71    0.00    1.95    0.43   87%  12% Delete counter

    3.84    1.95    7.81    0.36   87%   9% Create alarm
    7.99    5.86   15.63    0.47   93%   3% Initialize alarm
    2.01    0.00    3.91    0.35   84%   6% Disable alarm
    6.53    5.86   13.67    1.01   75%  75% Enable alarm
    2.32    1.95    3.91    0.59   81%  81% Delete alarm
    4.76    3.91    7.81    1.01   59%  59% Tick counter [1 alarm]
   19.53   17.58   23.44    0.24   90%   6% Tick counter [many alarms]
    7.57    5.86   13.67    0.75   75%  21% Tick & fire counter [1 alarm]
   98.57   97.66  105.47    1.14   96%  62% Tick & fire counters [>1 together]
   22.15   21.48   27.34    0.96   71%  71% Tick & fire counters [>1 separately]
  359.18  357.42  384.77    1.10   65%  31% Alarm latency [0 threads]
  362.63  357.42  396.48    2.55   43%  27% Alarm latency [2 threads]
  408.22  402.34  416.02    2.73   55%  21% Alarm latency [many threads]
  378.63  375.00  494.14    2.56   93%  71% Alarm -> thread resume latency
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    9.78    5.86   19.53    0.00            Clock/interrupt latency

   12.21    5.86   31.25    0.00            Clock DSR latency

   12       0     316  (main stack:   752)  Thread stack used (1120 total)
All done, main stack            : stack used   752 size  2400
All done             :  Interrupt stack used   288 size  4096
All done             : Idlethread stack used   276 size  2048

Timing complete - 30550 ms total

PASS:<Basic timing OK>
EXIT:<done>

Board: ARM PID Evaluation Board

CPU :  ARM 7TDMI 20 MHz

Startup, main stack             : stack used   404 size  2400
Startup              :  Interrupt stack used   136 size  4096
Startup              : Idlethread stack used    84 size  2048

eCos Kernel Timings
Notes: all times are in microseconds (.000001) unless otherwise stated

Reading the hardware clock takes 6 ’ticks’ overhead
... this value will be factored out of all other measurements
Clock interrupt took  120.74 microseconds (150 raw clock ticks)

Testing parameters:
   Clock samples:            32
   Threads:                  50
   Thread switches:         128
   Mutexes:                  32
   Mailboxes:                32
   Semaphores:               32
   Scheduler operations:    128
   Counters:                 32
   Alarms:                   32

                                 Confidence
     Ave     Min     Max     Var  Ave  Min  Function
  ======  ======  ======  ====== ========== ========
   99.01   68.00  129.60   15.62   50%  26% Create thread
   21.60   21.60   21.60    0.00  100% 100% Yield thread [all suspended]
   15.65   15.20   16.00    0.39   56%  44% Suspend [suspended] thread
   15.79   15.20   16.00    0.31   74%  26% Resume thread
   23.65   23.20   24.00    0.39   56%  44% Set priority
    2.26    1.60    2.40    0.24   82%  18% Get priority
   51.39   51.20   52.00    0.29   76%  76% Kill [suspended] thread
   21.60   21.60   21.60    0.00  100% 100% Yield [no other] thread
   29.47   28.00   29.60    0.22   86%   2% Resume [suspended low prio] thread
   15.60   15.20   16.00    0.40  100%  50% Resume [runnable low prio] thread
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   27.73   24.00   28.00    0.40   74%   2% Suspend [runnable] thread
   21.60   21.60   21.60    0.00  100% 100% Yield [only low prio] thread
   15.65   15.20   16.00    0.39   56%  44% Suspend [runnable->not runnable]
   51.39   51.20   52.00    0.29   76%  76% Kill [runnable] thread
   27.66   27.20   28.80    0.41   54%  44% Destroy [dead] thread
   68.93   64.80   69.60    0.35   72%   2% Destroy [runnable] thread
   91.26   90.40  107.20    0.64   66%  32% Resume [high priority] thread
   49.14   48.80   49.60    0.39   57%  57% Thread switch

    2.20    1.60    2.40    0.30   75%  25% Scheduler lock
   10.20    9.60   10.40    0.30   75%  25% Scheduler unlock [0 threads]
   10.20    9.60   10.40    0.30   75%  25% Scheduler unlock [1 suspended]
   10.20    9.60   10.40    0.30   75%  25% Scheduler unlock [many suspended]
   10.20    9.60   10.40    0.30   75%  25% Scheduler unlock [many low prio]

    6.85    6.40    7.20    0.39   56%  43% Init mutex
   18.40   18.40   18.40    0.00  100% 100% Lock [unlocked] mutex
   19.57   19.20   20.00    0.40   53%  53% Unlock [locked] mutex
   16.55   16.00   16.80    0.34   68%  31% Trylock [unlocked] mutex
   14.55   14.40   15.20    0.24   81%  81% Trylock [locked] mutex
    3.55    3.20    4.00    0.39   56%  56% Destroy mutex
  119.85  119.20  120.00    0.24   81%  18% Unlock/Lock mutex

   12.85   12.80   13.60    0.09   93%  93% Create mbox
    1.65    1.60    2.40    0.09   93%  93% Peek [empty] mbox
   20.70   20.00   20.80    0.17   87%  12% Put [first] mbox
    1.65    1.60    2.40    0.09   93%  93% Peek [1 msg] mbox
   20.70   20.00   20.80    0.17   87%  12% Put [second] mbox
    1.65    1.60    2.40    0.09   93%  93% Peek [2 msgs] mbox
   20.85   20.80   21.60    0.09   93%  93% Get [first] mbox
   20.85   20.80   21.60    0.09   93%  93% Get [second] mbox
   19.90   19.20   20.00    0.17   87%  12% Tryput [first] mbox
   17.60   17.60   17.60    0.00  100% 100% Peek item [non-empty] mbox
   20.90   20.80   21.60    0.17   87%  87% Tryget [non-empty] mbox
   16.80   16.80   16.80    0.00  100% 100% Peek item [empty] mbox
   17.65   17.60   18.40    0.09   93%  93% Tryget [empty] mbox
    1.85    1.60    2.40    0.34   68%  68% Waiting to get mbox
    1.85    1.60    2.40    0.34   68%  68% Waiting to put mbox
   19.40   19.20   20.00    0.30   75%  75% Delete mbox
   65.05   64.80   65.60    0.34   68%  68% Put/Get mbox

    7.05    6.40    7.20    0.24   81%  18% Init semaphore
   15.55   15.20   16.00    0.39   56%  56% Post [0] semaphore
   17.35   16.80   17.60    0.34   68%  31% Wait [1] semaphore
   14.60   14.40   15.20    0.30   75%  75% Trywait [0] semaphore
   14.20   13.60   14.40    0.30   75%  25% Trywait [1] semaphore
    4.55    4.00    4.80    0.34   68%  31% Peek semaphore
    3.75    3.20    4.00    0.34   68%  31% Destroy semaphore
   70.85   70.40   71.20    0.39   56%  43% Post/Wait semaphore

    6.05    5.60    6.40    0.39   56%  43% Create counter
    2.25    1.60    2.40    0.24   81%  18% Get counter value
    2.25    1.60    2.40    0.24   81%  18% Set counter value
   19.70   19.20   20.00    0.37   62%  37% Tick counter
    3.45    3.20    4.00    0.34   68%  68% Delete counter

    9.05    8.80    9.60    0.34   68%  68% Create alarm
   29.60   29.60   29.60    0.00  100% 100% Initialize alarm
    2.15    1.60    2.40    0.34   68%  31% Disable alarm
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   29.35   28.80   29.60    0.34   68%  31% Enable alarm
    5.10    4.80    5.60    0.37   62%  62% Delete alarm
   23.20   23.20   23.20    0.00  100% 100% Tick counter [1 alarm]
  138.00  137.60  138.40    0.40  100%  50% Tick counter [many alarms]
   40.40   40.00   40.80    0.40  100%  50% Tick & fire counter [1 alarm]
  704.25  697.60  804.00   12.47   93%  93% Tick & fire counters [>1 together]
  155.20  155.20  155.20    0.00  100% 100% Tick & fire counters [>1 separately]
  105.20  104.80  151.20    0.76   99%  94% Alarm latency [0 threads]
  117.57  104.80  149.60    7.13   57%  25% Alarm latency [2 threads]
  117.49  104.80  148.80    7.10   58%  26% Alarm latency [many threads]
  192.59  177.60  316.00    1.93   98%   0% Alarm -> thread resume latency

   22.10   21.60   24.00    0.00            Clock/interrupt latency

   38.69   32.80   61.60    0.00            Clock DSR latency

  297     276     316  (main stack:   752)  Thread stack used (1120 total)
All done, main stack            : stack used   752 size  2400
All done             :  Interrupt stack used   288 size  4096
All done             : Idlethread stack used   272 size  2048

Timing complete - 30350 ms total

PASS:<Basic timing OK>
EXIT:<done>

Board: ARM PID Evaluation Board

CPU :  ARM 920T 20 MHz
-------------------------------

Startup, main stack             : stack used   404 size  2400
Startup              :  Interrupt stack used   136 size  4096
Startup              : Idlethread stack used    84 size  2048

eCos Kernel Timings
Notes: all times are in microseconds (.000001) unless otherwise stated

Reading the hardware clock takes 15 ’ticks’ overhead
... this value will be factored out of all other measurements
Clock interrupt took  291.41 microseconds (364 raw clock ticks)

Testing parameters:
   Clock samples:            32
   Threads:                  50
   Thread switches:         128
   Mutexes:                  32
   Mailboxes:                32
   Semaphores:               32
   Scheduler operations:    128
   Counters:                 32
   Alarms:                   32

                                 Confidence
     Ave     Min     Max     Var  Ave  Min  Function
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  ======  ======  ======  ====== ========== ========
  257.78  168.00  568.00   48.70   56%  28% Create thread
   50.21   49.60   50.40    0.29   76%  24% Yield thread [all suspended]
   36.26   36.00   36.80    0.35   68%  68% Suspend [suspended] thread
   37.20   36.80   37.60    0.40  100%  50% Resume thread
   56.24   56.00   56.80    0.34   70%  70% Set priority
    5.20    4.80    5.60    0.40  100%  50% Get priority
  122.75  122.40  123.20    0.39   56%  56% Kill [suspended] thread
   50.19   49.60   50.40    0.31   74%  26% Yield [no other] thread
   69.49   66.40   69.60    0.21   92%   2% Resume [suspended low prio] thread
   37.01   36.80   37.60    0.31   74%  74% Resume [runnable low prio] thread
   64.75   55.20   65.60    0.38   80%   2% Suspend [runnable] thread
   50.19   49.60   50.40    0.31   74%  26% Yield [only low prio] thread
   36.24   36.00   36.80    0.34   70%  70% Suspend [runnable->not runnable]
  122.75  122.40  123.20    0.39   56%  56% Kill [runnable] thread
   67.76   67.20   68.00    0.34   70%  30% Destroy [dead] thread
  167.07  158.40  168.00    0.35   92%   2% Destroy [runnable] thread
  213.49  212.00  249.60    1.46   84%  90% Resume [high priority] thread
  122.81  120.00  389.60    4.17   99%  99% Thread switch

    4.70    4.00    4.80    0.17   87%  12% Scheduler lock
   23.70   23.20   24.00    0.37   62%  37% Scheduler unlock [0 threads]
   23.60   23.20   24.00    0.40  100%  50% Scheduler unlock [1 suspended]
   23.70   23.20   24.00    0.37   62%  37% Scheduler unlock [many suspended]
   23.60   23.20   24.00    0.40  100%  50% Scheduler unlock [many low prio]

   15.65   15.20   16.00    0.39   56%  43% Init mutex
   42.40   42.40   42.40    0.00  100% 100% Lock [unlocked] mutex
   45.37   44.80   46.40    0.36   65%  31% Unlock [locked] mutex
   39.20   39.20   39.20    0.00  100% 100% Trylock [unlocked] mutex
   34.45   34.40   35.20    0.09   93%  93% Trylock [locked] mutex
    8.00    8.00    8.00    0.00  100% 100% Destroy mutex
  284.42  284.00  284.80    0.40   53%  46% Unlock/Lock mutex

   29.40   28.80   29.60    0.30   75%  25% Create mbox
    3.35    3.20    4.00    0.24   81%  81% Peek [empty] mbox
   49.35   48.80   49.60    0.34   68%  31% Put [first] mbox
    3.35    3.20    4.00    0.24   81%  81% Peek [1 msg] mbox
   49.35   48.80   49.60    0.34   68%  31% Put [second] mbox
    3.35    3.20    4.00    0.24   81%  81% Peek [2 msgs] mbox
   49.15   48.80   49.60    0.39   56%  56% Get [first] mbox
   49.15   48.80   49.60    0.39   56%  56% Get [second] mbox
   47.80   47.20   48.00    0.30   75%  25% Tryput [first] mbox
   41.40   40.80   41.60    0.30   75%  25% Peek item [non-empty] mbox
   49.40   48.80   49.60    0.30   75%  25% Tryget [non-empty] mbox
   40.15   40.00   40.80    0.24   81%  81% Peek item [empty] mbox
   40.95   40.80   41.60    0.24   81%  81% Tryget [empty] mbox
    4.05    4.00    4.80    0.09   93%  93% Waiting to get mbox
    4.05    4.00    4.80    0.09   93%  93% Waiting to put mbox
   45.60   45.60   45.60    0.00  100% 100% Delete mbox
  153.27  152.80  153.60    0.39   59%  40% Put/Get mbox

   16.80   16.80   16.80    0.00  100% 100% Init semaphore
   36.60   36.00   36.80    0.30   75%  25% Post [0] semaphore
   39.60   39.20   40.00    0.40  100%  50% Wait [1] semaphore
   34.80   34.40   35.20    0.40  100%  50% Trywait [0] semaphore
   33.35   32.80   33.60    0.34   68%  31% Trywait [1] semaphore
   10.30    9.60   10.40    0.17   87%  12% Peek semaphore
    8.80    8.80    8.80    0.00  100% 100% Destroy semaphore
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  166.92  166.40  167.20    0.36   65%  34% Post/Wait semaphore

   13.60   13.60   13.60    0.00  100% 100% Create counter
    4.85    4.80    5.60    0.09   93%  93% Get counter value
    4.80    4.80    4.80    0.00  100% 100% Set counter value
   45.25   44.80   45.60    0.39   56%  43% Tick counter
    7.75    7.20    8.00    0.34   68%  31% Delete counter

   20.80   20.80   20.80    0.00  100% 100% Create alarm
   69.30   68.80   69.60    0.37   62%  37% Initialize alarm
    4.80    4.80    4.80    0.00  100% 100% Disable alarm
   67.35   67.20   68.00    0.24   81%  81% Enable alarm
   11.80   11.20   12.00    0.30   75%  25% Delete alarm
   54.80   54.40   55.20    0.40  100%  50% Tick counter [1 alarm]
  372.35  363.20  652.80   17.53   96%  96% Tick counter [many alarms]
   95.50   95.20   96.00    0.37   62%  62% Tick & fire counter [1 alarm]
 1757.92 1707.20 1996.80   81.43   81%  81% Tick & fire counters [>1 together]
  404.37  404.00  404.80    0.40   53%  53% Tick & fire counters [>1 separately]
  256.57  254.40  395.20    2.17   98%  97% Alarm latency [0 threads]
  296.60  255.20  359.20   23.53   53%  31% Alarm latency [2 threads]
  307.49  265.60  357.60   27.52   53%  53% Alarm latency [many threads]
  467.04  432.00  788.80    5.03   97%   1% Alarm -> thread resume latency

   55.63   54.40   60.80    0.00            Clock/interrupt latency

  101.23   80.80 1433.60    0.00            Clock DSR latency

  316     316     316  (main stack:   752)  Thread stack used (1120 total)
All done, main stack            : stack used   752 size  2400
All done             :  Interrupt stack used   288 size  4096
All done             : Idlethread stack used   272 size  2048

Timing complete - 30780 ms total

PASS:<Basic timing OK>
EXIT:<done>
eCos Getting Started with eCos ■ 103



RED HAT ECOS PUBLIC LICENSE Version 1.1
 Appendix 2: eCos Licensing

RED HAT ECOS PUBLIC LICENSE
Version 1.1
1. DEFINITIONS.

1.1. “Contributor” means each entity that creates or  contributes to the 
creation of Modifications.

1.2. “Contributor Version” means the combination of  the Original Code, prior 
Modifications used by a  Contributor, and the Modifications made by that 
particular  Contributor.

1.3. “Covered Code” means the Original Code or  Modifications or the 
combination of the Original Code and  Modifications, in each case including 
portions thereof.

1.4. “Electronic Distribution Mechanism” means a  mechanism generally accepted 
in the software development  community for the electronic transfer of data.

1.5. “Executable” means Covered Code in any form other  than Source Code.

1.6. “Initial Developer” means the individual or  entity identified as the 
Initial Developer in the Source  Code notice required by Exhibit A.

1.7. “Larger Work” means a work which combines Covered  Code or portions 
thereof with code not governed by the terms  of this License.

1.8. “License” means this document.

1.9. “Modifications” means any addition to or deletion  from the substance or 
structure of either the Original Code  or any previous Modifications. When 
Covered Code is released  as a series of files, a Modification is:

A. Any addition to or deletion from the contents  of a file containing Original 
Code or previous  Modifications.

B. Any new file that contains any part of the  Original Code or previous 
Modifications.

1.10. “Original Code” means Source Code of computer  software code which is 
described in the Source Code notice  required by Exhibit A as Original Code, 
and which, at the  time of its release under this License is not already  
Covered Code governed by this License.
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1.11. “Source Code” means the preferred form of the  Covered Code for making 
modifications to it, including all  modules it contains, plus any associated 
interface  definition files, scripts used to control compilation and  
installation of an Executable, or a list of source code  differential 
comparisons against either the Original Code or  another well known, available 
Covered Code of the  Contributor’s choice. The Source Code can be in a 
compressed  or archival form, provided the appropriate decompression or  de-
archiving software is widely available for no charge.

1.12. “You” means an individual or a legal entity  exercising rights under, and 
complying with all of the terms  of, this License or a future version of this 
License issued  under Section 6.1. For legal entities, “You” includes any  
entity which controls, is controlled by, or is under common  control with You. 
For purposes of this definition,  “control” means (a) the power, direct or 
indirect, to cause  the direction or management of such entity, whether by  
contract or otherwise, or (b) ownership of fifty percent  (50%) or more of the 
outstanding shares or beneficial  ownership of such entity.

1.13. “Red Hat Branded Code” is code that Red Hat distributes and/or permits 
others to distribute under different terms than the Red Hat eCos Public 
License. Red Hat’s Branded Code may contain part or all of  the Covered Code.

2. SOURCE CODE LICENSE.

2.1. The Initial Developer Grant. The Initial Developer hereby grants You a 
world-wide,  royalty-free, non-exclusive license, subject to third party  
intellectual property claims:

(a) to use, reproduce, modify, display, perform,  sublicense and distribute the 
Original Code (or portions  thereof) with or without Modifications, or as part 
of a  Larger Work; and

(b) under patents now or hereafter owned or  controlled by Initial Developer, 
to make, have made, use and  sell (“Utilize”) the Original Code (or portions 
thereof),  but solely to the extent that any such patent is reasonably  
necessary to enable You to Utilize the Original Code (or  portions thereof) and 
not to any greater extent that may be  necessary to Utilize further 
Modifications or combinations.

2.2. Contributor Grant. Each Contributor hereby grants You a world-wide,  
royalty-free, non-exclusive license, subject to third party  intellectual 
property claims:

(a) to use, reproduce, modify, display, perform,  sublicense and distribute the 
Modifications created by such  Contributor (or portions thereof) either on an 
unmodified  basis, with other Modifications, as Covered Code or as part  of a 
Larger Work; and

(b) under patents now or hereafter owned or  controlled by Contributor, to 
Utilize the Contributor  Version (or portions thereof), but solely to the 
extent that  any such patent is reasonably necessary to enable You to  Utilize 
the Contributor Version (or portions thereof), and  not to any greater extent 
that may be necessary to Utilize  further Modifications or combinations.

3. DISTRIBUTION OBLIGATIONS.

3.1. Application of License. The Modifications which You create or to which You  
contribute are governed by the terms of this License,  including without 
limitation Section 2.2. The Source Code  version of Covered Code may be 
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distributed only under the  terms of this License or a future version of this 
License  released under Section 6.1, and You must include a copy of  this 
License with every copy of the Source Code You  distribute. You may not offer or 
impose any terms on any  Source Code version that alters or restricts the 
applicable  version of this License or the recipients rights hereunder. 
However, You may include an additional document offering the  additional rights 
described in Section 3.5.

3.2. Availability of Source Code. Any Modification which You create or to which 
You  contribute must be made available in Source Code form under  the terms of 
this License via an accepted Electronic  Distribution Mechanism to anyone to 
whom you made an  Executable version available and to the Initial Developer;  
and if made available via Electronic Distribution Mechanism,  must remain 
available for at least twelve (12) months after  the date it initially became 
available, or at least six (6)  months after a subsequent version of that 
particular  Modification has been made available to such recipients. You  are 
responsible for ensuring that the Source Code version  remains available even 
if the Electronic Distribution  Mechanism is maintained by a third party. You 
are  responsible for notifying the Initial Developer of the  Modification and 
the location of the Source if a contact  means is provided. Red Hat will be 
acting as maintainer of  the Source and may provide an Electronic Distribution  
mechanism for the Modification to be made available. You can  contact Red Hat 
to make the Modification available and to  notify the Initial Developer.

3.3. Description of Modifications. You must cause all Covered Code to which you 
contribute  to contain a file documenting the changes You made to create  that 
Covered Code and the date of any change. You must  include a prominent 
statement that the Modification is  derived, directly or indirectly, from 
Original Code provided  by the Initial Developer and including the name of the  
Initial Developer in (a) the Source Code, and (b) in any  notice in an 
Executable version or related documentation in  which You describe the origin 
or ownership of the Covered  Code.

3.4. Intellectual Property Matters

(a) Third Party Claims. If You have knowledge that a party claims an  
intellectual property right in particular functionality or  code (or its 
utilization under this License), you must  include a text file with the source 
code distribution titled  “LEGAL” which describes the claim and the party 
making the  claim in sufficient detail that a recipient will know whom  to 
contact. If you obtain such knowledge after You make Your  Modification 
available as described in Section 3.2, You  shall promptly modify the LEGAL 
file in all copies You make  available thereafter and shall take other steps 
(such as  notifying appropriate mailing lists or newsgroups)  reasonably 
calculated to inform those who received the  Covered Code that new knowledge 
has been obtained.

(b) Contributor APIs. If Your Modification is an application programming  
interface and You own or control patents which are  reasonably necessary to 
implement that API, you must also  include this information in the LEGAL file.

3.5. Required Notices. You must duplicate the notice in Exhibit A in each file  
of the Source Code, and this License in any documentation  for the Source Code, 
where You describe recipients rights  relating to Covered Code. If You created 
one or more  Modification(s), You may add your name as a Contributor to  the 
Source Code. If it is not possible to put such notice in  a particular Source 
Code file due to its structure, then you  must include such notice in a location 
(such as a relevant  directory file) where a user would be likely to look for  
such a notice. You may choose to offer, and to charge a fee  for, warranty, 
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support, indemnity or liability obligations  to one or more recipients of 
Covered Code. However, You may do so only on Your own behalf, and not  on behalf 
of the Initial Developer or any Contributor. You  must make it absolutely clear 
that any such warranty,  support, indemnity or liability obligation is offered 
by You  alone, and You hereby agree to indemnify the Initial  Developer and 
every Contributor for any liability incurred  by the Initial Developer or such 
Contributor as a result of  warranty, support, indemnity or liability terms You 
offer.

3.6. Distribution of Executable Versions. You may distribute Covered Code in 
Executable form only  if the requirements of Section 3.1-3.5 have been met for  
that Covered Code, and if You include a notice stating that  the Source Code 
version of the Covered Code is available  under the terms of this License, 
including a description of  how and where You have fulfilled the obligations of 
Section  3.2. The notice must be conspicuously included in any notice  in an 
Executable version, related documentation or  collateral in which You describe 
recipients rights relating  to the Covered Code. You may distribute the 
Executable  version of Covered Code under a license of Your choice,  which may 
contain terms different from this License,  provided that You are in compliance 
with the terms of this  License and that the license for the Executable version 
does  not attempt to limit or alter the recipients rights in the  Source Code 
version from the rights set forth in this  License. If You distribute the 
Executable version under a  different license You must make it absolutely clear 
that any  terms which differ from this License are offered by You  alone, not by 
the Initial Developer or any Contributor. You  hereby agree to indemnify the 
Initial Developer and every  Contributor for any liability incurred by the 
Initial  Developer or such Contributor as a result of any such terms  You offer. 
If you distribute executable versions containing  Covered Code, you must 
reproduce the notice in Exhibit B in  the documentation and/or other materials 
provided with the  product.

3.7. Larger Works. You may create a Larger Work by combining Covered Code  with 
other code not governed by the terms of this License  and distribute the Larger 
Work as a single product. In such  a case, You must make sure the requirements 
of this License  are fulfilled for the Covered Code.

4. INABILITY TO COMPLY DUE TO STATUTE OR REGULATION.

If it is impossible for You to comply with any of the  terms of this License 
with respect to some or all of the  Covered Code due to statute or regulation 
then You must: (a)  comply with the terms of this License to the maximum extent  
possible; (b) cite the statute or regulation that prohibits  you from adhering 
to the license; and (c) describe the  limitations and the code they affect. 
Such description must  be included in the LEGAL file described in Section 3.4 
and  must be included with all distributions of the Source Code. Except to the 
extent prohibited by statute or regulation,  such description must be 
sufficiently detailed for a  recipient of ordinary skill to be able to 
understand it. You  must submit this LEGAL file to Red Hat for review, and You  
will not be able use the covered code in any means until  permission is granted 
from Red Hat to allow for the inability  to comply due to statute or regulation.

5. APPLICATION OF THIS LICENSE.

This License applies to code to which the Initial  Developer has attached the 
notice in Exhibit A, and to  related Covered Code.

Red Hat may include Covered Code in products without  such additional products 
becoming subject to the terms of  this License, and may license such additional 
products on  different terms from those contained in this License. Red Hat may 
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license the Source Code of Red Hat Branded  Code without Red Hat Branded Code 
becoming subject to the  terms of this License, and may license Red Hat Branded 
Code  on different terms from those contained in this License. Contact Red Hat 
for details of alternate licensing terms  available.

6. VERSIONS OF THE LICENSE.

6.1. New Versions. Red Hat may publish revised and/or new versions of the  
License from time to time. Each version will be given a  distinguishing version 
number.

6.2. Effect of New Versions. Once Covered Code has been published under a 
particular  version of the License, You may always continue to use it  under the 
terms of that version. You may also choose to use  such Covered Code under the 
terms of any subsequent version  of the License published by Red Hat. No one 
other than Red Hat  has the right to modify the terms applicable to Covered Code  
beyond what is granted under this and subsequent Licenses.

6.3. Derivative Works. If you create or use a modified version of this License  
(which you may only do in order to apply it to code which is  not already 
Covered Code governed by this License), you must  (a) rename Your license so 
that the phrases “ECOS”, “eCos”,  “Red Hat”, “RHEPL” or any confusingly similar 
phrase do not  appear anywhere in your license and (b) otherwise make it  clear 
that your version of the license contains terms which  differ from the Red Hat 
eCos Public License. (Filling in the name of the Initial Developer, Original 
Code or Contributor in the notice described in Exhibit A shall not of 
themselves be deemed to be modifications of this License.)

7. DISCLAIMER OF WARRANTY.

COVERED CODE IS PROVIDED UNDER THIS LICENSE ON AN “AS  IS” BASIS, WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED  OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, WARRANTIES THAT  THE COVERED CODE IS FREE OF DEFECTS, MERCHANTABLE, 
FIT FOR A  PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE RISK AS TO  THE 
QUALITY AND PERFORMANCE OF THE COVERED CODE IS WITH YOU. SHOULD ANY COVERED 
CODE PROVE DEFECTIVE IN ANY RESPECT, YOU  (NOT THE INITIAL DEVELOPER OR ANY 
OTHER CONTRIBUTOR) ASSUME  THE COST OF ANY NECESSARY SERVICING, REPAIR OR 
CORRECTION. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF  THIS 
LICENSE. NO USE OF ANY COVERED CODE IS AUTHORIZED  HEREUNDER EXCEPT UNDER THIS 
DISCLAIMER.

8. TERMINATION.

This License and the rights granted hereunder will  terminate automatically if 
You fail to comply with terms  herein and fail to cure such breach within 30 
days of  becoming aware of the breach. All sublicenses to the Covered  Code 
which are properly granted shall survive any  termination of this License. 
Provisions which, by their  nature, must remain in effect beyond the 
termination of this  License shall survive.

9. LIMITATION OF LIABILITY.

UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY,  WHETHER TORT (INCLUDING 
NEGLIGENCE), CONTRACT, OR OTHERWISE,  SHALL THE INITIAL DEVELOPER, ANY OTHER 
CONTRIBUTOR, OR ANY  DISTRIBUTOR OF COVERED CODE, OR ANY SUPPLIER OF ANY OF 
SUCH  PARTIES, BE LIABLE TO YOU OR ANY OTHER PERSON FOR ANY  INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF  ANY CHARACTER INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR  LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR  
MALFUNCTION, OR ANY AND ALL OTHER COMMERCIAL DAMAGES OR  LOSSES, EVEN IF SUCH 
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PARTY SHALL HAVE BEEN INFORMED OF THE  POSSIBILITY OF SUCH DAMAGES. THIS 
LIMITATION OF LIABILITY  SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL 
INJURY  RESULTING FROM SUCH PARTY’S NEGLIGENCE TO THE EXTENT  APPLICABLE LAW 
PROHIBITS SUCH LIMITATION. SOME JURISDICTIONS  DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR  CONSEQUENTIAL DAMAGES, SO THAT EXCLUSION AND 
LIMITATION MAY  NOT APPLY TO YOU.

10. U.S. GOVERNMENT END USERS.

The Covered Code is a “commercial item,” as that term  is defined in 48 C.F.R. 
2.101 (Oct. 1995), consisting of  “commercial computer software” and 
“commercial computer  software documentation,” as such terms are used in 48  
C.F.R. 12.212 (Sept. 1995). Consistent with 48 C.F.R. 12.212  and 48 C.F.R. 
227.7202-1 through 227.7202-4 (June 1995), all  U.S. Government End Users 
acquire Covered Code with only  those rights set forth herein.

11. MISCELLANEOUS.

This License represents the complete agreement  concerning subject matter 
hereof. If any provision of this  License is held to be unenforceable, such 
provision shall be  reformed only to the extent necessary to make it  
enforceable. This License shall be governed by California  law provisions 
(except to the extent applicable law, if any,  provides otherwise), excluding 
its conflict-of-law  provisions. With respect to disputes in which at least one  
party is a citizen of, or an entity chartered or registered  to do business in, 
the United States of America: (a) unless  otherwise agreed in writing, all 
disputes relating to this  License (excepting any dispute relating to 
intellectual  property rights) shall be subject to final and binding  
arbitration, with the losing party paying all costs of  arbitration; (b) any 
arbitration relating to this Agreement  shall be held in Santa Clara County, 
California, under the  auspices of JAMS/EndDispute; and (c) any litigation 
relating  to this Agreement shall be subject to the jurisdiction of  the 
Federal Courts of the Northern District of California,  with venue lying in 
Santa Clara County, California, with the  losing party responsible for costs, 
including without  limitation, court costs and reasonable attorneys fees and  
expenses. The application of the United Nations Convention  on Contracts for 
the International Sale of Goods is  expressly excluded. Any law or regulation 
which provides  that the language of a contract shall be construed against  the 
drafter shall not apply to this License.

12. RESPONSIBILITY FOR CLAIMS.

Except in cases where another Contributor has failed to  comply with Section 
3.4, You are responsible for damages  arising, directly or indirectly, out of 
Your utilization of  rights under this License, based on the number of copies 
of  Covered Code you made available, the revenues you received  from utilizing 
such rights, and other relevant factors. You  agree to work with affected 
parties to distribute  responsibility on an equitable basis.

13. ADDITIONAL TERMS APPLICABLE TO THE RED HAT ECOS  PUBLIC LICENSE.

Nothing in this License shall be interpreted to  prohibit Red Hat from 
licensing under different terms than  this License any code which Red Hat 
otherwise would have a  right to license.

Red Hat and logo - This License does not grant any  rights to use the trademark 
Red Hat, the Red Hat logo,  eCos logo, even if such marks are included in the 
Original  Code. You may contact Red Hat for permission to display the  Red Hat 
and eCos marks in either the documentation or the  Executable version beyond 
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that required in Exhibit B.

Inability to Comply Due to Contractual Obligation - To  the extent that Red Hat 
is limited contractually from making  third party code available under this 
License, Red Hat may  choose to integrate such third party code into Covered 
Code  without being required to distribute such third party code  in Source 
Code form, even if such third party code would  otherwise be considered 
“Modifications” under this License.

EXHIBIT A.

The contents of this file are subject to the Red Hat eCos Public License  
Version 1.1 (the “License”); you may not use this file except in  compliance 
with the License. You may obtain a copy of the License at  http://
www.redhat.com

Software distributed under the License is distributed on an “AS IS”  basis, 
WITHOUT WARRANTY OF ANY KIND, either express or implied. See the  License for 
the specific language governing rights and limitations under  the License.

The Original Code is eCos - Embedded Configurable Operating System,  released 
September 30, 1998.

The Initial Developer of the Original Code is Red Hat. Portions created by Red 
Hat are Copyright (C) 1998, 1999, 2000 Red Hat, Inc. All Rights Reserved.

EXHIBIT B.

Part of the software embedded in this product is eCos -  Embedded Configurable 
Operating System, a trademark of Red Hat. Portions created by Red Hat are 
Copyright (C) 1998, 1999, 2000  Red Hat, Inc. (http://www.redhat.com) All 
Rights Reserved.

THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY RED  HAT AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING,  BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF  
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE  DISCLAIMED. IN NO 
EVENT SHALL THE AUTHOR BE LIABLE FOR ANY  DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR  CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,  
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,  DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED  AND ON ANY THEORY OF LIABILITY, WHETHER 
IN CONTRACT, STRICT  LIABILITY, OR TORT(INCLUDING NEGLIGENCE OR OTHERWISE)  
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF  ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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Appendix 3: The eCos Copyright 
Assignment Form, Revision 1.1

Rationale
This preamble describes how to use the standard eCos copyright assignment form. 
The rationale behind this assignment is to avoid any possible confusion over the legal 
ownership of eCos, and to indemnify Red Hat and all eCos users against copyright or 
patent claims on contributed code used within eCos. Red Hat would be especially 
vulnerable, but all users and their eCos based applications could be affected. 

All contributions to eCos for which there are copyright assignments will be covered 
by the Red Hat eCos public license. The license provides a guarantee that the 
contribution will remain freely available to all. 

This agreement gives Red Hat ownership of your changes but promises that you will 
retain the right to use your contributed changes as you see fit. 

Because employers often can claim ownership over things that employees write, you 
may also have to get your employer to sign a disclaimer that says that they have no 
claim to the changes you are contributing. 

Please read everything, and if you have any questions, email 

ecos-assign@redhat.com 

for help. 

Thanks for your contribution to eCos! 

How to assign copyright
The way to assign copyright to Red Hat is to sign an assignment contract. This is what 
makes Red Hat the legal copyright holder, so that Red Hat can register the copyright 
on the new version. 
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If you are employed as a programmer (even at a university), or have made an 
agreement with your employer or school that gives them ownership of the software 
you write, then Red Hat needs a signed letter from your employer disclaiming rights to 
the contributed software. 

The disclaimer should be printed on the company’s headed paper, and signed by an 
officer of the company, or someone authorized to license the company’s intellectual 
property. Here is an example of wording that can be used for this purpose: 

<INSERT COMPANY NAME> hereby disclaims all copyright interest in the changes 
and enhancements made by <INSERT YOUR NAME> to eCos, including any future 
revisions of these changes and enhancements. 

<INSERT COMPANY NAME> affirms that it has no other intellectual property 
interest that would undermine this release, or the use of eCos, and will do nothing to 
undermine it in the future.

<INSERT SIGNATURE OF OFFICER OF COMPANY>, 
<INSERT DATE>
<INSERT PRINTED NAME OF OFFICER OF COMPANY>   
<INSERT TITLE OF OFFICER>

If your employer says they do have an intellectual property claim that could conflict 
with the use of the program, then please contact Red Hat to discuss possible next 
steps. 

Below is the usual assignment contract. You need to edit and replace <INSERT 
NAME OF CONTRIBUTOR> with your full name. Please print a copy, sign, date, 
and mail it to: 

Legal Department (eCos Assignments)
Red Hat, Inc. 
2600 Meridian Parkway 
NC 27713 
USA       

Don’t forget to include the original signed copy of the employer’s disclaimer. 

Please try to print the whole first page of the form on a single piece of paper. If it 
doesn’t fit on one printed page, put it on two sides of a single piece of paper, and 
attach the second page of the form. Please write the date using letters rather than 
numbers to avoid any confusion due to international day/month ordering conventions. 

Note: This text is also available in the eCos software distribution, in the file assign.txt.

  --------------------------------- Cut Here ----------------------------------

eCos ASSIGNMENT
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For good and valuable consideration, receipt of which I acknowledge, I,  
<INSERT NAME OF CONTRIBUTOR>, hereby transfer to Red Hat, Inc. my entire  
right, title, and interest (including all rights under copyright) in my  
changes and enhancements to eCos, subject to the conditions below. These 
changes and enhancements are herein called the “Work”. The Work  hereby 
assigned shall also include any future revisions of these changes and  
enhancements hereafter made by me.

Upon thirty days prior written notice, Red Hat agrees to grant me  non-
exclusive rights to use the Work (i.e. just my changes and enhancements,  not 
eCos as a whole) as I see fit; (and Red Hat’s rights shall otherwise  continue 
unchanged).

I hereby agree that if I have or acquire hereafter any patent or interface  
copyright or other intellectual property interest dominating the software  
enhanced by the Work (or use of that software), such dominating interest will  
not be used to undermine the effect of this assignment, i.e. Red Hat and the  
general public will be licensed to use, in that program and its derivative  
works, without royalty or limitation, the subject matter of the dominating  
interest. This license provision will be binding on my heirs, assignees, or  
other successors to the dominating interest, as well as on me.

I hereby represent and warrant that I am the sole copyright holder for the  Work 
and that I have the right and power to enter into this contract. I hereby  
indemnify and hold harmless Red Hat, its officers, employees, and agents  
against any and all claims, actions or damages (including attorney’s  
reasonable fees) asserted by or paid to any party on account of a breach or  
alleged breach of the foregoing warranty. I make no other express or implied  
warranty (including without limitation, in this disclaimer of warranty, any  
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE).

Agreed:  [signature]

  [Print Name]

  Date:  [Please write using letters]

For Red Hat:

 Date:

 -------------------- Cut Here and print on separate page ---------------------

[Please print your name here]

[For the copyright registration, of what country are you a citizen?]

[In what year were you born?]

[Please write your email address here]
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[Please write your address here, so we can mail a signed copy of the agreement 
back to you]

[Please write a brief description of the contribution]

[Which files have you changed so far, and which new files have you written so 
far?]
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